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Motivation for Writing this Book 

My reason for writing another “Introduction to SolidWorks” book is to emphasize the role and 
importance of computer aided design (CAD) and engineering drawings in communicating design 
ideas. The old adage “a picture is worth a thousand words” is true in mechanical engineering 
design. Often it is impossible to describe a complex design in words and we must use 
engineering drawings. 

Many introductory CAD tutorials focus only on the software and train students to be skilled CAD 
operators. This book also places equal emphasis on creating engineering drawings that comply 
with accepted design standards. Although much effort and resources have been expended in 
technologies that reduce or eliminate the need for paper documents, most organizations still 
depend on engineering drawings in paper or electronic form. 

Engineering drawings are still the most important and efficient method of communication 
between the design and manufacturing functions. They are also necessary for the maintenance 
and repair of consumer and industrial products as varied as automobiles, airplanes, earth 
moving equipment and cruise ships. Lastly, engineering drawings are legal documents and 
commonly used to determine and apportion fault in product liability lawsuits. For all these 
reasons, every engineering and manufacturing professional must be proficient at creating, 
understanding and using engineering drawings. 

Target Audience 

This book is written primarily for classroom instruction at the high school, vocational and college 
levels. With that audience in mind, SolidWorks commands are introduced while designing a 
skateboard. 

Experienced CAD professionals that want to learn SolidWorks on their own will also find the 
book useful. The book is organized in a way that allows experienced users to easily find and 
learn the commands needed to customize SolidWorks, and to create solid models, assemblies 
and drawings. 

All readers, students, as well as practicing professionals, will find that this is also an excellent 
reference book. The alphabetical index at the end of the book can be used to find information 
about the most common SolidWorks commands and examples of how they are used. For those 
interested in more thorough command of SolidWorks beyond the introductory level, the website 
provides additional instruction and references.  

Prerequisites 

To get the maximum benefit from this book, the reader must be computer literate and familiar 
with the complementary roles of hardware and software. In addition, the reader must be familiar 
with the Windows operating system. SolidWorks was one of the earliest CAD programs written 
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specifically to run within Windows and takes full advantage of the Windows interface, and file 
naming and handling conventions. 

How to Use this Book 

This book has two goals: first, it is a tutorial that teaches how to use SolidWorks at an 
introductory level, and second, the book also teaches how engineering drafting conventions and 
standards are used to communicate design ideas. The main text teaches the commands 
needed to create a solid model of a skateboard and then to use the model to produce working 
drawings. If the reader follows only the main text, the book is a step-by-step tutorial to gain an 
introductory knowledge of SolidWorks and of its most useful commands. To get the best results, 
read the step-by-step tutorial and practice with your SolidWorks software and computer as you 
read. The CD available in our website contains an audiovisual tutorial that follows the main text 
and is intended as an alternative for readers who prefer to see a demonstration instead of 
following written instructions. The CD can be ordered from the website www.cadeducators.com. 

We also recommend the use of the SolidProfessor video course as an optional way of studying 
SolidWorks in depth and for updating skills annually when a new version is released. You can 
find additional information at www.solidprofessor.com. Each Lesson has a list of the relevant 
topics in SolidProfessor. It is recommended that you watch the SolidProfessor topics listed 
before or after the lesson to maximize your learning.  

The information that is not directly related to the skateboard model is included in the book’s 
sidebars and in the supporting website. Each sidebar is self-contained and should be read 
independently from the main text. The sidebars will: 

1) explain the use of SolidWorks commands and command options in detail, or 

2) introduce and explain drafting conventions and standards, or 

3) explain the role of CAD in the design process. 

All the sidebars in a lesson should be read before moving to the next lesson. 

The website is an integral part of the book. It has information about annual enhancements to the 
software and advanced topics beyond the introductory level. If you find that a figure in the book 
does not match your version of SolidWorks, visit the website to see what has changed.  

Finally, we recommend that you subscribe to SolidProfessor while you use this book to learn 
SolidWorks. This is optional, but the information provided by SolidProfessor is an excellent 
reinforcement to the material learned in the book. SolidProfessor also covers advanced topics 
not included in the book or in the website. You can register to use SolidProfessor in our website 
www.cadeducators.com or in the SoildProfessor website http://www.solidprofessor.com/. Each 
Lesson in this book has a list of the useful topics in SolidProfessor that you can use to maximize 
your learning.   

Together, the written and CD tutorials, the sidebars, the website and the SolidProfessor lessons 
recommended, will accommodate different learning styles. If a subject must be studied in 
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greater depth than it is covered in the book or the website, consult the references at the end of 
each lesson or the SolidProfessor curriculum. 

This book is divided into sections and each Section is further divided into Lessons. Every 
Lesson has practice exercises and questions. The practice exercises give students the 
opportunity to use the SolidWorks commands learned in the Lesson in new situations. For 
example, although English units are used in the text, some practice exercises use metric units 
instead.  Questions are used to reinforce and expand the student’s knowledge of design and 
drafting practices. It is important to complete the questions and practice exercises to achieve 
the most learning possible. 

The Appendix includes two complete sets of working drawings. One set uses the ANSI standard 
and English units (inch and pound) and the other set uses the ISO standard and metric units 
(millimeter and gram). The drawings are to be used by the student to determine the dimensions 
needed to create the solid models, assemblies and drawings. Because the student is expected 
to find in the drawings the dimensions needed to create the models, the text rarely reveals them 
after the first few Lessons. The benefit of this approach is that the student becomes familiar with 
drawings and the information they contain. Classroom experience has shown that students will 
be comfortable with this approach. 

The Appendix also has a list of all the commands on the Main Drop-down Menu and in the 
CommandManager. To find additional information about each command and how it is used, the 
reader can use SolidWorks Help or the alphabetical index at the end of the book. 

Conventions 

• Click is used when pressing the left-button on the mouse. 
• Right-click is used when pressing the right-hand-button. 
• Double-click is used when pressing the left-button of the mouse two times quickly. 
• Right-drag is used to initiate mouse gestures. In the graphics area, press the right button 

and drag. The tool highlighted is the one in the drag direction.   
• Click, hold and drag are the sequences used for moving toolbars or icons from one 

location to another. 
• HelpSolidWorks Help is the sequence of clicks to achieve an action. 
• Bold letters are used to indicate Windows commands. 
• Italic Bold letters are used to indicate SolidWorks commands or input request. 
• Steps are numbered sequentially from the beginning to the end of the book. This is to 

facilitate communication between the student and the teacher. The numbered steps also 
permit the combination of two books into one document. The SolidWorks tutorial is the 
sequence of steps and can be followed without interference from the drafting practices 
lessons in the sidebars. The numbered steps teach SolidWorks and the sidebars teach 
drafting. 
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Lesson 1 – Introducing SolidWorks 

1.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Explain how to start SolidWorks. 
 Explain the SolidWorks Interface. 
 Explain how SolidWorks files are named. 
 Explain the difference between a part and an assembly of parts. 
 Explain the difference between a part drawing and an assembly drawing. 
 Explain concurrent engineering. 

1.2 Introduction 

SolidWorks is a modern 
computer aided design (CAD) 
program. It enables designers 
to create a mathematically 
correct solid model of an 
object that can be stored in a 
database. When the 
mathematical model of a part 
or assembly is associated with 
the properties of the materials 
used, we get a solid model 
that can be used to simulate 
and predict the behavior of the 
part or model with finite 
element and other simulation 
software. The same solid 
model can be used to 
manufacture the object and 
also contains the information 
necessary to inspect and 
assemble the product. The 
marketing organization can produce sales brochures and videos that introduce the product to 
potential customers. SolidWorks and similar CAD programs have made possible concurrent 
engineering, where all the groups that contribute to the product development process can share 
information on real-time. 

Concurrent Engineering 
The practice of sharing the solid model throughout the 
organization is called concurrent engineering. It can reduce the 
time it takes to develop a new product. Previous to concurrent 
engineering, the design group had to complete the design before 
the manufacturing organization decided how to make each part. 
For example, if a part is injection molded, the manufacturing 
organization must design the mold. With concurrent engineering, 
manufacturing personnel does not have to wait for the drawings of 
the part to be complete and can use the solid model to design the 
mold in parallel. If the design of the part changes, the new 
dimensions are available to the manufacturing organization in 
real-time and the mold design always reflect the latest 
information. In addition to reducing the product development time, 
this early involvement of the manufacturing organization promotes 
better communication that reduces errors and improves product 
quality. 
The ultimate expression of concurrent is the integrated product 
team (IPT). The team includes representation from all the 
company stakeholders including the design and manufacturing 
organizations, the field maintenance organization, and the 
marketing, accounting and legal departments. 
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1.3 Starting SolidWorks 

Step 1: To start SolidWorks, click on the SolidWorks icon shown in 
Figure 1.1. It should be on your desktop. If the SolidWorks icon is not on 
your desktop, you can start the program from the start menu by clicking 
StartAll ProgramsSolidWorksSolidWorks. You can also use 
Windows Explorer or “Windows Search” to find the file sldworks.exe in the 
directory C:\Program Files\SolidWorks\SolidWorks. Double-click to start 
the program. 

After you start SolidWorks you will see a familiar 
Windows desktop. Notice, in Figure 1.2 that: 

1. The SolidWorks banner is at the top-left 
corner. 

2. The Windows Main Drop-down Menu is 
adjacent to the banner. It includes the 
Windows drop-down menus File, View, 
Tools and Help. 

3. Other menus will appear when needed, 
depending on what you are doing. 

If you do not see the 
Main Drop-down 
Menu, move your 
mouse cursor over 
the SolidWorks 
banner to show it. To 
keep it visible, push 
on the pin. 

When the pin is 
horizontal, you can 
toggle between the 
Main Drop-down 
Menu and the 
Standard toolbar 
(with icons) 
immediately to the 
right of the Main 
Drop-down Menu by 
moving the mouse 
cursor over the 
banner. 

Figure 1.1 – 
SolidWorks Icon 

SolidWorks and Windows 
SolidWorks is fully integrated into Windows. 
The look and feel of the SolidWorks desktop 
is similar to the Windows desktop. SolidWorks  
Part files are stored as  *.sldprt, where * is the 
filename.  Assembly files are stored as  
*.sldasm and Drawing files as  *.slddrw. It is 
also possible to save templates for parts, 
assemblies and drawings as  *.prtdot, 
*.asmdot and *.drwdot. Templates customize 
how SolidWorks looks and works. 

Figure 1.2 – SolidWorks Desktop 
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Finally, if you wish to see the content of a drop-down menu, click on its label. 

4. The Standard toolbar, includes the icons for commonly used Windows and SolidWorks 
commands; for example New, Open, Save and Print a document, Rebuild your model 
and Undo and Redo. The content of the toolbar can vary because it is possible to 
customize it. We will learn to customize toolbars in Lesson 2. 

Notice that if you place the mouse cursor over one of the icons, you can see what 
command it represents and also the command’s keyboard-shortcut equivalent. 

5. On the bottom of the screen you can see the Windows Start Button and Taskbar. 

6. On the right side of the screen you can find the Task Pane. It has icons for SolidWorks 
Resources, Design Library and for the SolidWorks File Explorer, which works like 
Windows Explorer. 

The Task Pane can be shown by clicking on one of the icons or hidden by clicking on 
the Graphics Area. The pin can be pushed to keep the Task Pane open and it must be 
horizontal to allow to toggle between visible and hidden. 

Next, explore the TaskPane and its contents. The SolidWorks Resources include the 
Online Tutorial and What’s New, as well as access to the SolidWorks Forum. In 
Design Library you can find Toolbox and 3DContentCentral. Both, Toolbox and 
3DContentCentral have models of parts that can be re-used in new assemblies. This is 
very convenient because screws, bearings, linear actuators and other catalog parts don’t 
have to be re-drawn. Toolbox resides on your desktop but it is an extra cost item and 
could be missing in your installation. 3DContentCentral requires internet access. 

Step 2: To open a new document, click on the icon New in the Standard toolbar (or click 
FileNew in the Main Drop-down Menu).  

To open an existing 
document, you must 
click the Open icon in 
the Standard toolbar 
(or FileNew in the 
Main Drop-down 
Menu). 

When we create a new 
document, we get either 
the novice or the expert 
screen in Figures 1.3a 
and 1.3b. It is possible 
to toggle between these 
options by clicking on 
the Advanced or 
Novice buttons at the 
lower left corner of the 

Figure 1.3a – Novice Screen for a New Document 
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menu box. The advantage of the Advanced menu is that you can select from the customized 
templates that we will create in Lesson 2. 

Notice that there are three kinds of documents in SolidWorks: 
(1) parts, 
(2) assemblies of parts, and 
(3) drawings of parts or assemblies. 

We will study them in that order in future lessons. 

1.4 The SolidWorks Interface 

Step 3: When you open a new Part document you get additional toolbars and pull-down menus as 
shown in Figure 1.4. 

 Toolbars and commands are context sensitive. The commands that are available and 
related to what the user is doing are in color and the commands that are not available 
are shown gray. 

A new toolbar is the View HeadsUp toolbar, at the top-center of the Graphics Area. It can be 
customized, as we shall see later. The question mark at the lower-right corner can be clicked to 
get help. 

Figure 1.3b – Advanced Screen for a New Document 
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Table 1.1 – SolidWorks Desktop for a New Part Document 

 
1- SolidWorks logo  11- FeatureManager Design Tree (also 

called the Feature Tree) 
2- Main Drop-down Menu 12- Origin (red or blue) 
3- Quick Access Toolbar (also called 

the Standard Toolbar) 
13- View (Heads-Up) toolbar 

4- File name  14- Minimize/Maximize/Close window 
(see also 6) 

5- SolidWorks search  15- Task pane 
6- Help (?) & Minimize/Maximize/Close 

window (see also 14) 
16- SolidWorks command description 

7- CommandManager  17- Reference triad 
8- CommandManager toolbars tabs  18- SolidWorks status bar & units 

selection 
9- Feature/Property/Configuration 

managers tabs 
19- Quick tips  

10- File name 20- Graphics area 

Figure 1.4 – SolidWorks Desktop for a New Part Document 
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Parts, Assemblies and Drawings 
An assembly is a group of parts that together make the complete product or a portion of the product. 
For example, an automobile is an assembly of parts, but for convenience, it can be subdivided into a 
frame sub-assembly, a powertrain sub-assembly, the air conditioning sub-assembly, etc. The 
powertrain sub-assembly can be further subdivided into the engine sub-assembly, the transmission 
sub-assembly, the wheel-tire sub-assembly, etc. 
Parts and assemblies are a convenient way to subdivide a product because they allow division of 
labor and specialization. If production resources, including employees, equipment and facilities, are 
dedicated exclusively to producing only one or a few parts or assemblies they can achieve efficiencies 
that are not possible otherwise. Specialization is the basis of mass production. The engine block, for 
example, is usually a casting. The engine camshaft is machined from a steel bar and the pistons can 
be cast or forged. Manufacturing each part requires different machinery and expertise. A typical 
automobile today has thousands of parts and dozens of sub-assemblies produced in manufacturing 
facilities located all over the world. 
Designers and design engineers create detail or part drawings primarily to enable the manufacturing 
of parts by different people in different locations. This requires that each detail or part drawing have all 
the information needed to make the part, and nothing extraneous that can cause confusion. For 
example, the part drawing for a camshaft must have one or more pictorial views of the part, derived 
from the solid model, and additional information such as dimensions and tolerances, material, finish, 
etc. On the other hand, there is no need for information about other engine parts such as the valves. 
Thus, each of the camshaft detail drawing and the valve detail drawing will have all the information 
needed to make each part but no information about how they fit together. The information needed to 
assemble the camshaft and the valve together belongs on the engine sub-assembly drawing. 
The first step when modeling a product is to break down the assembly into sub-assemblies and parts. 
This is a very important step that will impact the quality and cost of the final product and the 
complexity of the model. Although there are exceptions to the rules, the following are important 
considerations when deciding what should be a part: 

1. Components made of different materials should be different parts. For example, a part 
should not be made of sheet metal with rubber bumper(s). Instead, create a sub-assembly 
that contains sheet metal part(s) and rubber part(s). 

2. Components made with different manufacturing processes should be different parts. For 
example, a typical steel file drawer has many sheet metal and machined parts assembled 
into drawers, cabinets, etc. This is also true for the finishing process. It is not practical to 
paint a portion of a part and chrome-plate another portion. It is more appropriate to have an 
assembly that contain painted parts and plated parts. 

3. Weldments are different. A Weldment is one part, even though it is made from many 
separate pieces. It should be drawn with all the final dimensions and tolerances after all the 
pieces are welded together. On the other hand, a book case is typically drawn as individual 
detail drawings for each shelf, plus an assembly drawing. The choice can be based on the 
degree of control available. A weldment is typically handmade and a book case is made with 
woodworking machinery. 

4. Use sub-assemblies when the parts complement to enable a function. For example, the 
wheel and tire together will enable the automobile to roll over the pavement. 

In addition to the detail or part drawings used to make the parts, the design organization will create 
assembly drawings to provide information about how the parts assemble together. The information in 
an assembly drawing is different than the information in a detail drawing because they have different 
purposes. The detail drawing is used to make the parts and the assembly drawing is used to assemble 
the parts into a product. 
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Practice Exercises 

1. Click HelpSolidWorksHelp on the Main Drop-down Menu and study the section 
User Interface. 

2. Click HelpSolidWorksHelp on the Main Drop-down Menu and use Search to find 
information about the CommandManager. 

3. Click HelpSolidWorksTutorials on the Main Drop-down Menu and find the 
Tutorial Lesson 1. Complete the exercise. (Caution: The units in the Tutorial are mm. A 
common error by beginners is to draw with the wrong units. The result will look identical 
in the monitor screen, but a part drawn in mm will be smaller than the same part drawn 
in inches.) 

4. On the Task Pane, click SolidWorks Resources click to visit the SolidWorks 
Discussion Forum. (You have to register to gain access.) Follow one thread and write a 
paragraph describing the discussion. 

5. On the Task Pane, find SolidWorks Resources and locate the most convenient 
SolidWorks user group that you can visit. 

6. On the Task Pane, open the Design Library and click to visit 3D Content Central. 
Download one file and open it from within SolidWorks. (Note: You have to register or log-
in before you can download files.) 

Questions 

1. You will need a partner to do this exercise. First, find the drawings of the deck in the 
Appendix. Describe the deck to your partner in words. Your partner will draw the part 
while you describe it. You can answer the questions that your partner asks for 
clarification and provide unrequested hints, but do not reveal the drawing or look at your 
partner’s representation of the part. When the drawing is complete, answer the following 
questions: 

a. How accurate is your partner’s final representation of the part? Is the result more 
accurate if both of you know about skateboarding and have the same mental 
image of the deck? 

b. How easy (or difficult) was it to communicate the information needed to draw the 
part? How long did it take? 

2. Research the origins and history of skateboarding and skateboards. 

3. Research the history of computers and CAD. 
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Lesson 2 – Customizing SolidWorks 

2.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Explain how to customize SolidWorks using ViewToolbarsCustomize and 

ToolsCustomize in the Main Drop-down Menu or OptionsCustomize in the 
Quick Access Toolbar. 

 Explain how to customize SolidWorks using ToolsOptions in the Main Drop-down 
Menu or Options in the Quick Access toolbar. 

 Explain how to customize SolidWorks by creating a part template. 
 Explain how to customize SolidWorks using ToolsAdd-Ins in the Main Drop-down 

Menu or OptionsAdd-Ins in the Quick 
Access toolbar. 

. Explain where to find SolidWorks files. 

2.2 Introduction 

SolidWorks can be customized to look and work 
according to your preferences, or to follow company 
standards. In this lesson, we will customize SolidWorks 
to reflect customary US practice. 

2.3 Customizing the Toolbars 

Step 4: Click ViewToolbars to see all the toolbars that 
are available. Toolbars that are visible have a check 
mark. See Figure 2.1. 

 Verify that the following toolbars are visible: 
CommandManager, View (Heads-Up), and 
Task Pane. 

 Check and uncheck one or more toolbars and 
see what difference it makes, but remember to 
undo your changes before proceeding to the 
next step. 

 All toolbars can be moved to a new location by 
clicking and dragging. The CommandManager 
can be moved by clicking and dragging to the Figure 2.1 – ViewToolbars 
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arrows on the center-top/right/left of the graphics area. 

 If you click OptionsCustomize in the Quick Access toolbar, the menu in Figure 2.2 
appears. It is another way of selecting which toolbars can be seen on the desktop. You 
can select which toolbars are shown by clicking to add the checkmark. 

 Two other ways of getting the menu in Figure 2.2 are by clicking ToolsCustomize in 
the Main Drop-down Menu or by clicking ViewToolbarsCustomize. 

Step 5: The commands in a 
toolbar can be changed. Click 
OptionsCustomize and then 
select the Commands tab to get 
the menu in Figure 2.3. This is a 
list of all the toolbars in 
SolidWorks. They are called 
Categories on this menu. 

If you click a Category, the icons 
shown on the right side of the 
menu box are the commands 
that belong in the toolbar. If you 
place the mouse cursor over 
each icon, you can see what 
command it represents. 
Some commands are not 
included in the default version of 
a toolbar, but can be added. 

Figure 2.2 – ViewToolbarsCustomize 
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To add a command, click and drag the icon to a 
toolbar. It will remain in the toolbar when you 
click OK to accept. You can place any command 
in any toolbar, even if it is unrelated, but it is best 
to keep toolbars small and concise. 

To remove a command from a toolbar, drag the 
icon from the toolbar back to the Customize 
menu. 

Step 6: In the CommandManager, click the tab 
Sketch to show the sketch commands. Next, on 
Options CustomizeCommandsSketch in 
Figure 2.3, locate the Ellipse tool. Click and drag 
it to the Sketch toolbar in the 
CommandManager and click OK. This will add 
the new command. 

 To remove the Ellipse icon from the 
CommandManager toolbar, click and 
drag the icon back and release the 
mouse button. 

2.4 Customizing with ToolsOptions 

Another way of customizing SolidWorks is by selecting ToolsOptions in the Main Drop-
down Menu (or Options in the Quick Access toolbar). The menu in Figure 2.4 will appear. It 
has two tabs, System Options and Document Properties. 

Figure 2.3 – ViewToolbarsCustomize 
CommandsSketchEllipse 
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Step 7: System Options. 

 Select Display Style on the System Options tab and verify that Tangent edges in new 
views: Removed. 

 Select Display/Selection on the System Options tab and verify that Projection Type for 
four viewport: is Third Angle. Also, Part/Assembly tangent edge display: Removed. 

 Select FeatureManager and change Design BinderShow and OriginShow. 

Step 8: Document Properties. 

 Click the Document Properties tab and select ANSI in Overall drafting standard. See 
Figure 2.5. 

 Click Units and select IPS (inch-pound-seconds). 

 Click OK. 

Figure 2.4 – ToolsOptions 
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2.5 Custom Properties 

Custom Properties allow storing information that will be used in drawings and in SolidWorks 
calculations. Click FileProperties in the Main Pull-down menu to get the screen in Figure 2.6. 
On the Summary tab, Figure 2.6a, we will fill as a minimum the Author and the Title. On the 
Custom tab, Figure 2.6b, fill the first column (Property Name) of the first four lines by typing       
1) Description, 2) Weight, 3) Material and 4) Finish. On the second column (Type) select Text 
from the pull-down menu for all the lines. Finally, on the third column (Value/Text Expression) 
leave 1) blank (to be filled later for each part/configuration). For line 2) select MASS from the 
pull-down menu on the right of the cell. For lines 3) and 4) leave blank. 
 
You can add other properties depending on the needs of your team. 
 
 
 

Figure 2.5 – ToolsOptionsDocument Properties 
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2.6 Saving a Template 

After you have customized SolidWorks you can save a template. The Template will bring your 
choice of toolbars and icons to every new document. Creating and using a template is the best 
way to insure that all the models, assemblies and drawings you create follow the drafting 
standard (e.g. ANSI or ISO) and units (e.g. inches or millimeters) that you want. 

 

 

Figure 2.6a – FileProperties, Summary tab 

Figure 2.6b – FileProperties, Custom tab 
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Step 9: Click FileSave As and 
select Part Template on the Save 
as type pull-down menu. See 
Figure 2.6 

 Name the template 
InchPart.prtdot and save 
it for future use. 

 After you save your 
template, close it before 
you draw and save a part. 
If you Fail to do this, 
SolidWorks will save your 
part as the template 

 The template is stored in 
the computer. If you want 
to store the template in 
your removable or network 
storage, follow the 
instructions in Step 10. 

Step 10: If you wish to save your templates on removable or network storage or in a sub-directory 
in your computer, you must first tell the SolidWorks the name of your storage device and its 
location. 

 First, save one or more templates to the location you wish to use. 

 In the Quick Access toolbar click Options System OptionsFile Locations. See 
Figure 2.7. 

 In the Drop-down menu for Show folders for: select Document Templates. 

 In Folders you will see the present location of the templates you see in Figure 1.3a and 
Figure 1.3b. 

 Click Add and browse to your removable storage device or desired storage location 
(where you stored the templates earlier). 

 Click OK and you will see the new location added. 

 Click OK again and answer Yes to add the new location. 

 Repeat Step 9 to save one or more templates in the new location. 

 Close your template document(s). 

 Open a new part and select the Advanced option. You will notice a new tab for your 
new location. Note: the tab will not be visible if you did not save a template first. 

Figure 2.7 – Saving a Part Template 
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2.7 Customizing with Add-Ins 

Add-Ins provide additional features and capabilities to SolidWorks. Some Add-Ins cost extra 
and may not be available in your version of the software. They are not part of your template, but 
once they are enabled during the session they will remain active until the end of the session. 
Although Add-Ins are very useful, they require additional memory. They should be kept disabled 
until needed. 

Step 11: Click on ToolsAdd-Ins to see which ones are available in your version of 
SolidWorks. See Figure 2.8. 

 If available, verify that the following Add-Ins have a check mark: SolidWorksToolbox 
and SolidWorksToolbox Browser. 

 You can add other Add-Ins, but remember that they use memory and could slow your 
computer. 

 

Figure 2.8 – SolidWorks File Location 
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2.8 Customizing with the View Menu 

The View menu on the Main Pull-down Menu is shown in Figure 2.9 and in Appendix D3. The 
entities highlighted will show on your SolidWorks graphics area. If the Origins are not 
highlighted, they will not be visible. Of special interest are the Temporary Axes. You will need 
them to use as axes of rotation in some commands. If you cannot find an axis to rotate about, 
click View and highlight Temporary Axes. 
  

Figure 2.9 – Add-Ins Menu 
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Figure 2.10 – View Pull-down Menu 
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Practice Exercises 

1. Click HelpSolidWorks Tutorials on the Main Drop-down Menu and study what 
tutorials are available. 

2. Add and then remove the command for a partial ellipse to the Sketch toolbar in the 
CommandManager. 

3. Create a part template for millimeter units. Set decimal places for length and for angles 
equal to zero. Select the ANSI standard. Call the template mmPart.prtdot. 

4. Use File Explorer to find the template that you created in Step 11. 

5. Save your Deck file in PDF format. 

Questions 

1. Search the Internet to find information about the following document formats supported 
by SolidWorks. Write a brief description of each one, including advantages, 
disadvantages and when you would use them. (Hint: You can search the internet using 
Google) 

ACIS                                          TIFF                                      VRML    
STEP                                         JPEG                                     PDF  
STL                                            IGES                                     Parasolid                                                                               

References 

SolidWorks Bible – by Matt Lombard, John Wiley and Sons, Indianapolis, IN, US 

SolidWorks Office Training Manual – by SolidWorks Corporation, Waltham, Massachusetts, US 

SolidWorks 2014 Short and Simple – by OnlineInstructor.org 

Introduction to Using SoildWorks – by W.E. Howard and J.C. Musto, McGraw Hill, New York, 
NY, US 
 
Videos from SolidProfessor SolidWorks for Beginners 

• View Manipulation 
• Starting a Part 
• Starting a Sketch 
• Sketch Tools 

Videos from SolidProfessor Core Concepts for Parts and Assemblies 
• Picking a plane 
• Design Intent 
• Custom Properties 
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Internet Resources 

CADeducators.com website: http://www.cadeducators.com  

SolidWorks website: http://www.solidworks.com 

SolidWorks models for download: http://www.3dcontentcentral.com/3dcontentcentral/ 

Popular CAD models for download: http://grabcad.com/library/software/solidworks  

SolidWorks training files: http://www.solidworks.com/sw/support/807_ENU_HTML.htm  
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Lesson 3 – Modeling the Skateboard 
Deck  Using  the Command 
Extruded Boss/Base 

3.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Model simple parts in SolidWorks. 
 Explain and use the CommandManager toolbar. 
 Explain and use the FeatureManager design tree. 
 Explain and use the PropertyManager menu. 
 Explain and use the Fillet and Chamfer commands in the Features tab of the 

CommandManager. 
 Explain and use the command Smart dimensions in the Sketch tab of the 

CommandManager or ToolsDimensionsSmart in the Main Drop-down Menu.  
 Explain and use the command Add Relations in the Display/Delete Relations pull-

down menu of the Sketch tab of the CommandManager or in ToolsRelationsAdd 
in the Main Drop-down Menu.  

• Learn to use the Hole Wizard. 
• Learn to constrain a model by using Dimensions and Sketch Relations. 
 Explain the difference between Sketch and Feature. 
 Explain and use Inferencing. 

3.2 Introduction 

When you open the template for a part, all the commands needed to create a solid model 
become available. The CommandManager toolbar will show tabs for the Sketch toolbar and 
the Features toolbar. As the name implies, the first can be used like a pencil and paper to 
create a 2D cross-section of the part. The second has the commands needed to extrude the 2D 
cross-section into a 3D solid. 

Many parts can be modeled by following five modeling steps: 

Modeling 1 – Select a sketch plane. 

 A common error made by beginners learning SolidWorks is forgetting to select 
the sketch plane. Forgetting to select the sketch plane can: 

1) create a sketch in the wrong plane, or 
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2) merge the new sketch with the previous sketch, or 
3) result in an error message. 

If you find yourself in one of these three these situations, use the Esc key to exit, 
and try again. 

Note: Sketch based features (e.g. Extrude Boss/Base and Revolved 
Boss/Base) can be created without selecting a plane first and while changing the 
order of the steps. After you become more proficient using SolidWorks you may 
choose to use these commands as sketch based features, but early in your 
learning it is advantageous to use the five steps as a standard procedure that 
guide you and prevent you from getting lost in the software. 

Modeling 2 – Sketch a cross-section of the part. 

 At this stage of the sketch, exact dimensions are not important. They will be 
added later. 

 It is helpful to use Inferencing. It makes the SolidWorks intelligent. Inferencing 
can guess the user’s intent and will suggest (or assume) appropriate relations 
between sketch entities. Some examples of relations are parallel, perpendicular, 
midpoint, etc. 

 One example of Inferencing is the dashed line that appears when the cursor is 
aligned with the origin in Figure 3.1. 

 For practice, use Inferencing to draw a horizontal line across the origin. 1)Click 
the Line tool in the CommandManager in the Sketch tab. 2)Hover the pencil 
cursor at a location that gives you the Inferencing line. 3)Click and drag across 
the origin and release to get the line. 4)Explore what happens when you slowly 
move the cursor up and down before releasing the left mouse button. 

 Even the most complex cross-section can be sketched. Maintain, as best as 
possible, the original proportions and relations (i.e. parallel, perpendicular, etc.). 
Be careful of unintended relations due to Inferencing. If necessary, break a 
complicated sketch into multiple simpler sketches. If the sketch becomes 
something you do not want, use Undo to step back and try something else. 
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 Sketch Planes and View Manipulation 
 

To sketch geometry in SolidWorks you must select a sketch plane first. SolidWorks gives you 
three choices: the Front, Top and Right planes at the beginning of the FeatureManager design 
tree (See Figure 1.4). I a latter Lesson we will learn that we can also sketch on any existing 
part surface that we created earlier.  
 
It is important to select a plane that will simplify creating the assembly. For example, if you 
look at drawing SKBD100 in Appendix A, you can see multiple views of the skateboard 
assembly. There are four views in total. The view on the right is called the isometric view 
because the orientation of the part to each rectangular axis (x, y, z) is the same, 30 degrees. 
The isometric view is sometimes the preferred view for making hand sketches because it 
shows parts and assemblies the way we see them from a distance. 
 
The three views on the left are called orthogonal views because they are rotated 90 degrees 
from each other. The view in the middle is called the Front view. The upper view is called the 
Top view and the lower view is called the Bottom view. They represent how the skateboard 
looks if we look from the top, edgewise and from the bottom.  
 
Notice that when sketching the line that will become the deck, we chose to sketch in the Front 
plane. If we had sketched in the right plane, the top of the skateboard would be in the Top 
view. In the Top view of the orthogonal projection, the skateboard would look standing up on 
its edge. This would look unstable when compared to the horizontal length that we have. It 
takes a little planning before we pick a sketch plane and start sketching. The best approach is 
to sketch an isometric view of the part or assembly first, then plan how you go from sketch to 
solid, and then decide which one is the Front plane, the Top plane and the Right plane. 
Alternatively, another way of selecting a sketch plane is to draw a part the way it looks in the 
assembly. If you can visualize or see the part in the assembly, you should draw accordingly. 
For example, the front view of the wheel in drawing SKBD121 looks identical to the wheel in 
the assembly SKBD100. 
 
The angle at which we look at the part or assembly is called the view orientation. During the 
process of creating a part or constructing an assembly we need to change the view orientation 
to see the part from different angles. There are many tools in SolidWorks to do that. The 
easiest tool to use is the space bar in your keyboard. If you tap on the space bar, you will get 
the orientation menu and the View Selector cube. The View Selector cube is explained in 
Appendix I. The orientation menu can also be seen if we click on the icon View Orientation 
on the View (Heads Up) toolbar (see Figure 1.4). 
 
When sketching, it is good practice to sketch when we can see the sketching plane in full size. 
This can be accomplished by clicking to make the sketch plane active, and then clicking View 
OrientationNormal To in the View (Heads Up) toolbar. 
 
Another way to change the view orientation is to use your mouse. If you press on the mouse 
middle button, and move the mouse, you will make your part rotate. Sometimes it is difficult to 
get the part to look the way you want, but it is easier if you move in one direction at a time, first 
horizontally and then vertically. You can also rotate and translate the part without rotation if 
you click on the appropriate icons in the View (Heads Up) toolbar. 
 
Zooming tools include Zoom to Fit, which will make the part or assembly occupy all the 
screen. It can also be used to bring back the model if you lost it. It can be found in the View 
(Heads Up) toolbar or by taping the key F in your keyboard. Zoom to Area is also in the 
View (Heads Up) toolbar and requires that we first click the icon, then press and hold the left 
button of the mouse  move to highlight the area we want  and release the button   
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Modeling 3 – Constrain your sketch by adding 
dimensions and sketch relations.  

 The sketch is fully defined when no blue lines are visible and all the lines are 
black. 

 Blue lines mean that you have to use Smart Dimensions and/or Add Relation 
commands to fully define and constrain the sketch. All the dimensions are in the 
drawings provided in the Appendix. 

 The sequence or order of your commands is important. Sometimes, as you define 
dimensions and sketch relations, the sketch will change into something that does 
not resemble what you want. Step back by using EditUndo on the Main Drop-
down Menu (or click the Undo icon in the Quick Access Menu) and try a 
different sequence of commands. In most situations, going back one step is 
enough to fix sketches. 

  

Figure 3.1 – Example of Inferencing 

Inferencing 
Inferencing will indicate that 
your line is horizontal or vertical, 
or that your mouse pointer is 
coincident or parallel to another 
line. This is a very useful feature 
when sketching. 
Unfortunately, sometimes 
SolidWorks will make the wrong 
assumption. To delete a sketch 
relation, click 
ToolsRelationsDisplay/Del
ete on the Main Drop-down 
Menu (or the delete key on your 
keyboard). You can click 
ToolsRelationsAdd to add 
relations that were not captured 
with Inferencing.  
You can see which relations you 
have in your sketch by clicking 
ToolsRelationsDisplay. 
It is possible to override 
Inferencing. On the Main Menu 
click ToolsSketch 
SettingsSketch Relations to 
toggle Inferencing on/off. If the 
symbols displaying sketch 
relations clutter your sketch, you 
can turn them on/off with 
ViewSketch Relations on the 
Main Menu. The checkmark 
indicates that they are visible. 

Smart Dimension 
Smart Dimension is the best command for 
dimensioning geometry in SolidWorks. It can be 
used as follows: 

1) click a line to dimension, 
2) click two points to dimension the distance, 
3) click a line and a point to dimension the 

distance, 
4) click two parallel lines to dimension the 

distance and 
5) click two lines that are not parallel to dimension 

the angle. 
Just by making the length of a line the desired value 
does not create a dimension. Always use Smart 
Dimension. 
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Modeling 4 – Use one or more command(s) from the Features toolbar to create the 
solid that you want. 

 The Features toolbar has commands that can be used to transform 2D sketches 
into 3D solids. The commands can be additive (Extruded Boss/Base and 
Revolved Boss/Base) or subtractive (Extruded Cut and Revolved Cut). 

 SolidWorks calls the 3D solids created with this toolbar Features, and they are 
listed in the FeaturesManager Design Tree (see Figure 1.4) in the same the 
order in which they are created. 

 Complex 3D solids and parts are created by repeating modeling steps 1 to 4 as 
needed. 

Constraining Sketches 
SolidWorks will allow the creation of 
features, parts and assemblies with 
sketches that are not fully defined (they 
still have blue lines), but it is very likely 
that the model will fail in the future. It is 
a best practice to fully define 
dimensions and relations to get a fully 
constrained sketch before proceeding 
to create a solid.  
Occasionally, after we add all the 
information we think is necessary, the 
sketch is still blue. This means that the 
sketch is not fully defined.  
To find what information is missing, we 
must ask the following two questions:  
     1) Did I specify the sizes of all the 

lines, circles, etc.?  
     2) Did I specify how far from the 

origin they are located?  
Another way of finding what is missing 
is by clicking and dragging the 
geometry. If it moves up-down, for 
example, it means that it is not fixed in 
that direction and it needs a vertical 
distance to the origin. If a line can 
stretch or a circle can change its 
diameter, it is because that dimension 
has not been specified.   

Overdefined Sketches 
Sometimes we provide more information than is 
necessary to define a sketch and the color of the 
lines changes to yellow or red. Yellow means that 
the geometry is over defined and has too many 
dimensions and/or relations. Red means that the 
geometry is impossible. To correct, undo the last 
step or delete one or more Dimensions or 
Relations and try something different. Always 
remember that the order in which Dimensions and 
Relations are specified is important. Try a different 
sequence. 
If you get the warning “Make Dimension driven?” 
you must decide based on design intent. If you 
choose to make the new dimension driving, you can 
help to resolve the problem when you use the 
SketchXpert.  
 On the lower right corner of your desktop 

(the status bar), click the red Over Defined 
warning. 

 On the left side of the screen you will get two 
options  

1) Diagnose and  
2) Manual Repair. 

 Diagnose will present you with a list of 
possible solutions. You must choose the one 
that agrees with your design intent. 

 Manual Repair will list the conflicting 
Dimensions and Relations. You must delete 
the unnecessary ones. 
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 The default option is to combine Features automatically as they are created, but 
it is possible to switch-off this option in the PropertyManager Design Tree to 
create multiple bodies. 

Modeling 5 – Document your design intent in the Design Binder for future reference. 

 Models, assemblies and drawings are created to communicate ideas. 
Documenting important information such as materials, requirements, references 
and sources of information, and renaming the features to make them easy to 
recognize is important. Never skip this step. As a minimum, record your name 
and the date you created the model in the Design Binder. 

The first four steps can be remembered as PSDF: Plane, Sketch, Dimension, Feature. 

 

3.3 The Skateboard Deck 

First, we will model the deck of the skateboard. Drawing SKTBD001 in Appendix A has all the 
information we need. We will use the five modeling steps in Section 3.2 to create the solid 
model. 

Step 12: Open a new document using the InchPart template and click to select the Front Plane in 
the FeatureManager design tree as shown in Figure 3.2. This will be the plane that we will use 
to sketch the cross-section of the part. In a cube, this is the plane in front of you. The other 
planes we could use to sketch are the top plane and the right side plane. A good idea is to hand 
sketch the assembly that you need and plan how you will create each part, including what plane 
is the best to use for sketching. 

Configuration Management 
Designs are usually re-used and/or modified over the production life of a product. Even if the 
product is no longer manufactured or sold, the company must maintain an inventory of 
replacement parts. For example, the B-52 bomber was designed during the 1950s and 
production ended during the 1960s but it is still in the U.S. Air Force inventory and the plan is 
to keep it flying until the middle of the 21st century. 
When product modifications and upgrades are needed, the changes are easier and safer if 
the design is well documented. Unfortunately, well documented designs are the exception. In 
well-run organizations, the responsibility of enforcing proper record keeping and of 
maintaining this information belongs to the Configuration Control or Configuration 
Management office. They use software variously known as product data managers (PDM), 
product life-cycle management (PLM), revision control software or change control software. 
The most important reason for documentation and formal record keeping is legal liability. 
Drawings, notebooks, e-mails and other communication can and will be used as legal 
evidence to determine liability in court cases. Poor quality documentation can result in a 
guilty verdict in a court case. 
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 When you place the mouse cursor over the Front Plane icon in the FeatureManager, a 
large red rectangle becomes visible. This is the front plane that we will use to sketch the 
cross-section of the skateboard. The square is only a portion of a plane that extends to 
infinity in the X and Y directions. A sketch outside the square is still in the front plane. 

 On the FeatureManager design tree, click the Front plane to sketch the cross-section 
of the part. 

Step 13: In the CommandManager, click the Sketch toolbar. This will make it active and the 
sketch commands will become visible. Next, click the Line command and sketch the skateboard 
cross-section as shown in Figure 3.3. 

 To sketch the line, click to start the line, drag the line to the location of the end point and 
release. To end the line, double-click after you release the mouse button. 

 
 To create a chain of lines, click-drag-release and repeat click-drag-release for the 

second line. Repeat drag and release until you have all the lines you need. To exit, you 
can double click or use Esc. Do not break the horizontal line into two lines. It must be 
one single line that extends past the origin. 

Figure 3.2 – Selecting the Front Plane 
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 With SolidWorks it is not necessary for the sketch to have exact dimension or angle. In 
this step, we only need approximate geometry. The next step will be to fully define, 
dimension and constrain the geometry. 

 Notice that when the Line tool is active, the mouse cursor will change into a symbol that 
looks like a pencil. Also, two icons on the confirmation corner at the top-right corner of 
the graphics area become visible. The two icons and the status bar at the bottom 
indicate that we are in sketch editing mode. To quit the sketch and retain your work, click 
the pencil icon. To discard your work, click the X icon. 

 To delete a line, click the line and then press the Delete key in your keyboard. 
Alternatively, click in the graphics area and drag your mouse over the line. Note:The 
complete line must be inside the highlighted area.  Next, release the mouse button and 
the line will change color. Finally, press the Delete key in your keyboard to erase the 
line. 

 Figure 3.3 – Sketching the Skateboard Cross-section 
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Step 14: Use Smart Dimension and Add Relation in the Display/Delete Relations pull down 
menu to fully define the geometry. When this step is complete there should not be any blue 
lines. 

 To input the skateboard dimensions, click the Smart Dimension tool in the Sketch 
toolbar of the CommandManager or ToolsDimensionsSmart. The mouse cursor 
changes to a dimension symbol. 

 Click the deck’s horizontal line, drag the mouse, and release. Click again to place the 
dimension. An input box will appear. Double click on the number in the input box and 
type the correct dimension, which in our case is 24 inches. If part of the sketch moves 
out of view, click the Zoom to fit icon in the View (Heads-Up) toolbar (see Figure 1.4). 

 Repeat for the right and left lines and make them 4 inches in length. 

 To dimension an angle, click on two lines and SolidWorks will show the angles between 
the lines. You must move around the vertex to see the various complementary and 
supplementary angles. The angles in our skateboard are 20 degrees as shown in Figure 
3.4.  

 
 Even when all lines have been dimensioned, they are still blue. This means that the 

sketch is not fully defined. SolidWorks needs more information. In addition to the 
dimensions, we must provide the location of the lines. We will do that by making the 
sketch symmetric about the origin. This will locate directly the horizontal line and 
indirectly the left and right lines, which are connected to the horizontal line. 

Figure 3.4 – Sketch with Dimensions 
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 Because the location of the lines is not fixed in space, we 
can click and drag them to a new location. Verify that the 
lines move. 

 To fix the lines, click ToolsRelationsAdd in the 
Main Drop-down Menu or Display/Delete 
RelationsAdd Relation in the Quick Access toolbar. 

 In the dialog box shown in Figure 3.5, verify that you 
have the blue box labeled Selected Entities. 

 Click the horizontal line and then the origin to select 
those entities. They will appear in the dialog box. 

 Click Midpoint in the Add Relations dialog box that 
appears and accept by clicking the check mark at the top 
of the box. 

 All lines will turn black to indicate that the sketch is now 
fully defined. 

 You can see what relations you have in your sketch by 
clicking ViewSketch Relations in the Main Drop-
down Menu. To see the relations the icon must be highlighted. If your sketch is 
cluttered, you can toggle them off. If you need to see them, you can toggle them on. 

Step 15: Next, use the Extruded Boss/Base command to create the width and the thickness of the 
skateboard. It can be found in the CommandManager and in the Main Drop-down Menu. 

 Click the Features tab in the CommandManager to make the toolbar active and show 
the commands available. 

 Click the Extruded Boss/Base command to get the dialog box in Figure 3.6. Select the 
Mid Plane option for Direction 1 and the Thin Feature. Type the dimension 8 inches for 
D1 and 1/2 inches down for T1. The Up and Down directions can be selected by 
choosing One-Direction in the first dialog box and then pressing the button with the 
arrows. When you toggle the button with the arrows you alternate between extruding up 
and extruding down. Verify that your extrusion is down. 

 Click the check mark to accept. The preview should look like Figure 3.6. 

 Direction 1 is the width (in and out of the screen). Thin Feature is for the thickness. 
Extruding down puts the origin in the top surface. 

Figure 3.5 – ToolsRelations 
Add Relations 
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At this point our model begins to looks like a skateboard, but it still needs a few details. 

Step 16: Create rounded corners by using the Fillet command and then you get the chamfer the 
edges of the deck. 

 Click on the Fillet tool in the Features toolbar to get the dialog in Figure 3.7. 

 Verify that you get the dialog box Items to Fillet. Click on all four corners of the 
skateboard and notice that the edges are now listed in the dialog box. 

 When clicking the corners, perhaps one or more corners are hidden from view. If you are 
in Display StyleShaded With Edges (in the View Heads-Up toolbar), click Display 
StyleHidden Lines Visible to see through the Deck. 

 Type the fillet radius of 4 inches. 

 Verify that the Full preview option is selected on the Items to Fillet menu to match 
Figure 3.7. 

 Use the commands in the View Heads-Up toolbar to move, rotate and zoom. 

After the preview shows all corners with the round fillets, click the check mark to accept. If for 
some reason the preview does not show the rounded corners, or looks different from the one on 
the figure, there is something wrong. Verify that all the options in your screen match the one 
shown in the figure. As a last resort, cancel the Fillet command by clicking X on the 
Confirmation Corner and repeat these steps. 

Figure 3.6 – Extrusion of the Sketch 
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 To chamfer the edges of the deck, click on the edges around the top and bottom 
surfaces. (Use Display StyleHidden Lines Visible when convenient.) 

 In the Features tab of the CommandManager, click the Fillet icon pull down menu and 
select the Chamfer command. 

 Select the Angle distance option and 0.125 inch and 45 degrees. See Figure 3.7b. 

 Click to accept. 

 

 

Figure 3.7a – Fillet Menu and Pre-view 

Display Style 
 

SolidWorks can display your part in different styles. On the View (Heads Up) toolbar 
click on the Display Style icon to see your options. The most cpu intensive option is 
Shaded with Edges. Wireframe is the easiest to display. In the early days of CAD, 
wireframes were the norm. Today, equipment is powerful enough that it is not important 
which display style is used. Still, some display styles are more descriptive than others 
and you might want to experiment to see which one you prefer. As an exercise, change 
the display style of the skateboard deck to see the difference. Many SolidWorks users 
believe that shaded with edges is the most realistic display style. Other options like 
Hidden Lines Visible or Wireframe are useful because it is possible to see details that 
are hidden in other views. 
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Step 17: In Figure 3.1, the sketch of the skateboard cross-section show a sharp transition 
between the horizontal line and the two ends that slope at 20 degrees. In the real world, this is 
impossible. We need a 1/4 inch radius on each of the transitions to allow for the bending radii at 
the two locations. To make the change we must edit the skateboard cross-section sketch. 

 On the CommandManager, select the Sketch tab. 
 On the Sketch toolbar, click Sketch Fillet. This is a fillet created while sketching and 

can be contrasted to the feature fillet created in Step 16. 

 On the dialog box, type 0.25. 

 Click on each of the two intersection points. 

 Click the check mark to accept. 

 

Step 18: Next, use the Hole Wizard to create the holes needed to attach the Truck and the wheels. 

 Click the skateboard top surface to make it the sketching plane before you click the Hole 
Wizard command. The Hole Wizard icon is located in the Feature tab of the 
CommandManager or you can find it in the Main Drop-down Menu at 
InsertFeatureHole Wizard. 

 Click Hole Wizard to get the dialog box in Figure 3.8. Select #8 countersunk flathead 
screws. Because the holes must be drilled through the thickness select Thru All as the 
end condition. Verify that your menu choices match the figure. 

 Next, click the Position tab to locate the holes. 

 
Figure 3.8b – Chamfer Menu 
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 SolidWorks asks for the location of the hole(s) and the cursor becomes a pencil. Click to 
mark the approximate location of two parallel holes as shown in Figure 3.9. Only the 
approximate location is required. Like any SolidWorks sketch, we will define the exact 
locations and sketch relations after we create the geometry. 

 The locations of the holes will be defined next. Click the Smart Dimension tool and use 
it to dimension the distance between the leading hole and the line where the deck is bent 
as shown in Figure 3.10. Type the distance 2 1/4 inches. 

 Dimension the distance between the two holes by clicking each hole and typing the 
dimension 3 inches. 

 Locate the front hole from the edge of the skateboard deck. The distance is 3 inches. 

 

 

Figure 3.9 – Hole Wizard Dialog Box 
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 If the two holes are not parallel, we must create a horizontal sketch relation between 
them first. Click ToolsRelationsAdd in the Main Drop-down Menu or in the 
CommandManager click the pull-down menu Display/Delete Relations and select Add 
Relation. 

 Click on the two points at the center of the holes and select Horizontal in the Add 
Relation dialog box. Click on the check mark to accept. (Note: If you used Inferencing 
to create two parallel holes, this step may not be necessary.) 

 The holes will change from blue to black to indicate that the sketch is now fully defined. 

 We are finally ready to create the countersunk holes. Click the check mark again to 
accept. 

Figure 3.10 – Hole WizardPositions Tab 
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Step 19: Use the Mirror command to duplicate the two holes. 

 Click the Mirror command in the Features toolbar. The dialog box is shown in 
Figure 3.12. The features we want to duplicate are the CSK (countersunk) holes for flat 
head machine screws. It should be visible in the Features to Mirror dialog box. If CSK 
is in the Features to Mirror dialog box, skip the next paragraph. 

 If CSK is not in the Features to Mirror dialog box, click the box to make it active and 
notice the new location of the FeatureManager design tree. It has moved to the 
Graphics Area to create space for the Mirror command dialog box. Click on the (+) sign 
of the FeatureManager design tree to expand the feature tree. As expected, this is a 
list of all the features created so far. Find and click on the CSK feature. It should be the 
last line in the feature tree. This will add CSK to the Features to Mirror dialog box. 

 The other information that SolidWorks needs to mirror the holes is the mirror plane. Click 
on the Mirror Face/Plane dialog box to make it active and then click Front Plane in the 
FeatureManager design tree. SolidWorks will show a preview of the new holes. 

 Click the check mark to accept. 

Figure 3.11 – Hole Locations 
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 Repeat the Mirror command across the Right plane to copy the Mirror1 feature to the 
other side, as seen in Figure 3.13. 

 

 

Figure 3.12 – Duplicating Two Holes Across the Front plane 

Figure 3.13 – Duplicating the 4-hole Pattern Across the Right plane 
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Step 20: Our skateboard model is now complete, but we need to save design information that 
others will need to understand our design. 

 Expand the Design Binder in the Feature Tree by clicking the 
+ sign. 

 Double-click Design Journal.doc to open. 

 Type a description of the part, its use and the material. 

 Type your name and the date for future reference. Type Save 
and then type Close. 

 The skateboard deck is made of pine wood. Right-click the 
Material icon in the FeatureManager design tree and then 
click Edit Material to get the Material Editor. Find the folder 
for Woods and click to show the types of wood available. 
Select Pine and click the check mark to accept. See 
Figure 3.14. 

 Click FileProperties and fill your name (Author) and 
SKATEBOARD DECK (Title and also Description) on the 
Summary tab and 1) SKBD101 (Part No). SolidWorks will 
assign the weight automatically if you selected the material. 

Step 21: Rename the features with more descriptive names. 

 This is shown in Figure 3.15, where the names assigned by 
SolidWorks to the deck features have been replaced by more 
descriptive names. 

 To change a Feature name, first make it active by clicking, and then click and hold for a 
second and release. You can now type the new name. 

 Another way to change the name is to right-click over the name and select Feature 
Properties. You can now type the new name. 

• Notice that we did not save the part as DECK because in most engineering organizations 
drawings are saved and retrieved by the drawing number and not by the name. The 
reason is that the number avoids duplication when we have, for example, two or more 
gears or pins. Another reason for using numbers is that the practice is a remnant from a 
long time ago when it was easier to automate the saving and retrieving of numbers 
instead of letters or names. 

• Another peculiarity in the file name is that all the letter are upper case. In Engineering 
drawings and sketches, lower case letters are never used. Hence, SKBD is the correct 
form and not skbd or Skbd. 

 The skateboard deck is finally complete. 

 Create a folder to store all your skateboard files and save your model as file SKBD101. 

Figure 3.14 – Materials 
Editor 
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Practice Exercises 

1. Click HelpSolidWorks Help on the Main Drop-down Menu, expand the 
Troubleshooting topic at the end of the Topics list (the left column) and study the 
sections Troubleshooting Resources and Errors. 

2. Use HelpSearch to learn about Sketch Relations. Write, in your own words a 
definition of the term and describe how you can take advantage of this feature of 
SolidWorks. 

3. Sketch a square and then use Extruded Boss/Base to create a bar with a square cross-
section. Click on Draft On/Off and see how your part changes. 

4. Explore the Extruded Boss/Base command. What other options are available besides 
Mid Plane? 

5. Click ToolsMass Properties and find the volume and weight of the skateboard deck. 
(Hint: to get the correct weight, you must first define the material in the FeatureManager 
design tree – see Step 20 and Step 73). 

6. Re-draw the parts modeled in this lesson using millimeters instead of inches. Use the 
mmPart template and the dimensions in the detail drawing in Appendix B. 

Questions 

1. Compare maple and pine as the material for the Deck. What are the advantages and 
disadvantages of each material? Which one you recommend? List the requirements and 
assumptions on which you base your recommendation. 

Part Numbers and Part Names 
Parts are tracked by their part number, not 
their part name. The reason is that it is easier 
to organize, store and retrieve a sequence of 
numbers than descriptive names. 
This is the reason why SolidWorks stores the 
name you use to save your file as the part 
number. 
A part number will typically include information 
about the project and the assembly where it 
belongs. For the skateboard deck, we will use 
SKBD100 for the top level assembly and 
SKBD101, SKBD102, etc. for the drawings. 
Drawing number SKBD110 is the Truck sub-
assembly and the drawings that belong are 
saved as SKBD111, SKBD112, etc. 

Figure 3.15 – Renaming 
Features 
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2. Search the Internet for information about Product Data Management. Describe what it is 
in your own words. 
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Lesson 4 – Modeling the Wheel 
Using  the  Revolve 
Command 

4.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Explain and use the Corner Rectangle command. 
 Explain and use the Revolve command. 
 Explain and use the Centerline command.  
 Explain and use the command Convert Entities and Offset Entities. 
 Explain why the Wheel Sub-assembly was not created as a single part. 
 Create part models using more than one PSDF sequence. 
 Learn to use the drawings in Appendix A to find the dimensions you need. 

4.2 Introduction 

The Revolve Boss/Base command, like the Extruded Boss/Base command in Lesson 3 can 
be used to create 3D solids from 2D sketches. Both commands belong in the Features toolbar. 
Extrude creates solids by elongating the 2D sketch in one or more directions and Revolve 
creates solids by rotating the sketch around an axis of revolution. 

4.3 Modeling the Wheel 

The wheels and tires should be two different parts because they are different materials and are 
made using completely different manufacturing processes. Skateboard wheels can be injection 
molded using a hard grade of polyurethane, a type of synthetic rubber. Skateboard wheels can 
also be made from steel. The tires are made with a softer polyurethane. The assembly of the 
wheel and tire is made by placing the wheel in a mold and pouring soft polyurethane around it. 

To create a model of the wheel, we will follow the five steps we learned at the beginning of 
Lesson 3: 

1) select a plane, 
2) sketch, 
3) add dimensions, 
4) use the Revolve command in the Features toolbar and, finally, 
5) document the design information and references. 
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Remember PSDF: Plane, Sketch, Dimension and Feature. 

Step 22: Open a new part with the InchPart template and select the Top plane for sketching. 

 If you hand sketch the skateboard to see how the various parts fits into the assembly, 
you will notice that the Top plane is the best to sketch this part.  

 Refer to the skateboard assembly drawing, drawing SKBD100 in the Appendix and 
Figure 4.2 below, the cross-section of the wheel. The cross-section will revolve around 
the line. 

Step 23: Create the wheel using the Revolve command. The wheel and the tire are both made of 
polyurethane. The wheel is a harder grade of polyurethane, compared to the tire. 

 In the Top plane, sketch the 
rectangle in Figure 4.1 using the 
Corner Rectangle command on 
the Sketch tab of the 
CommandManager. 

 Notice that Corner Rectangle is 
one of many ways of creating a 
rectangle. If you click on the pull-
down menu, you will see that you 
can make a Center Rectangle, a 3 
Point Rectangle and a 
Parallelogram. Type each of these 
commands in the Search box, 
select SolidWorks Help in the pull-
down menu and click the 
magnifying glass to see how they 
are used. 

 In the Sketch tab, click the Centerline command on the Line pull-down menu.  

 Sketch the construction line shown in the figure. The Centerline is parallel to the sides 
of the rectangle. Note: Centerlines or construction lines are for the benefit of humans 
and invisible to some SolidWorks calculations. In this example, the Centerline is the axis 
of rotation but is not part of the solid created.  

 Use the Smart Dimension tool to fully define the sketch. The dimensions are shown in 
the detail drawing of the wheel in the Appendix (SKBD121).  

 Notice that the height of the rectangle is 1.25 inch. It is the height of the cylinder that will 
be created when the rectangle rotates around the axis. 

 The distance from the left vertical line of the rectangle to the centerline is one half of 
0.87 inch (you can type 0.435 inch in the input box or 0.87/2). The inside diameter of the 
wheel is indicated by the Greek letter Φ and equals 0.87. The units are given in the Title 
Block, the rectangle in the lower right corner of the drawing. The Title Block has the 
name of the part (WHEEL), the part number (SKBD121), the material 
(POLYURETHANE) and above the material it says “DIMENSIONS ARE IN INCHES). 

Figure 4.1 – Wheel Sketch 
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 Notice that the drawing says 2X (i.e. two times) before the diameter. The reason is that 
there are two pockets for two bearings. The 2X indicates that both pockets have the 
same diameter. 

 The distance from the right vertical line of the rectangle to the center line is one-half of 
1.37 inch (0.685 inch). The outside diameter of the wheel in 1.37 inches.  

 The width of the rectangle is one-half of 1.37-0.87 inch (0.25 inch). We must divide by 
two because when we revolve the rectangle, the cross-section will show two rectangles. 
One rectangle on each side of the centerline. This dimension is not in the drawing 
because it is redundant. It can be calculated from the other dimensions given.  

 Redundant dimensions are called “double dimensioning” and when shown in a drawing 
they must be enclosed in parentheses. They are called reference dimensions and are 
shown for convenience. Remember the rule: All the dimensions must be in the drawing 
but never use double dimensions. 

 Notice that the sketch is still free to move up and down if we pull on the top or bottom 
blue lines because it is not fully constrained. To fully constrain we must dimension the 
distance from the origin to the top or bottom line. Click the height or 1.25 inch dimension 
and it will show in the input box. Next divide by two (/2). This defines the location of the 
line as ½ of the height and fixes the rectangle. It is important to click on the height and 
not type 1.25” because the number could change in the future. All the lines will turn black 
and the rectangle cannot move anymore.    

 Next, we will revolve the rectangle around the centerline. See Figure 4.2. 

 On the Features tab, Click FeaturesRevolved Boss/Base to get the menu in Figure 
4.2. The only input request is the axis of revolution. 

 Figure 4.2 – FeaturesRevolved Boss/Base 
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 Move the cursor over the centerline and SolidWorks will show a preview of the revolved 
solid in Figure 4.2. 

 Click the check mark to accept. 

Step 24: Next, we will create a spacer to separate the two bearings. We always use two bearings 
instead of only one to balance the 
loads acting on the part. 

 Select the Front plane. Click 
View OrientationNormal 
To in the View (Heads Up) 
toolbar to see the sketching 
plane full size. 

 Click the Sketch icon on the 
Sketch tab in the 
CommandManager. 

 Click Convert Entities and 
then click the inside diameter 
of the cylinder to create a 
circle on the Front plane with 
the same diameter as the 
inside diameter of the 
cylinder. The new circle will 
be the larger diameter of the 
spacer we are going to 
create.  

 Click the line created and 
then click Offset Entities in the CommandManagerSketch tab. This will be the 
smaller diameter of the spacer. From the drawing of the wheel, notice that we must type 
(0.87-0.25)/2. This will be the offset needed in the input box. Remember that both circles 
were sketched on the Front plane. Notice that you can type the equation to calculate the 
offset. 

 Extrude the spacer by clicking FeaturesExtruded Boss/Base in the Main Pull-down 
menu or Extrude Boss/Base in the Features tab in the CommandManager. 

 In Direction 1, use the pull-down menu to select Midplane. 

 Type the thickness of the spacer in D1. In the drawing SKBD121 we can see that the 
thickness of the spacer is 1.25-2(0.5) = 0.25 inch. (Remember that the total height of the 
cylinder is 1.25 inches. Also, remember that there are two pockets for bearings and each 
pocket is 0.5 in deep). 

 Click the check mark to accept. 

 To see the interior of the part, click ViewDisplaySection View (You can find 
Section View on the Main Drop-down Menu at the top of your screen or in the View 

Figure 4.3 – Skateboard Wheel 
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Heads-up toolbar. See Figure 1.4). Select the Top plane or right plane to cut the part 
and create a cross-section like Figure 4.3.   

 To go back to the complete part, click on the Section View command again. 

Step 25: Save the important design information: 

 Make the material polyurethane. 

 Fill the Design Journal with your name, date, part description and material. 

 In FileProperties type your name (Author), Skateboard Wheel (Title and 
Description) and SKBD121 (PART NO) 

 Save your part file as SKBD121.  

Practice Exercises 

1. Model the skateboard rubber tire. 

2.     Model the wheel using the Extruded Boss/Base command instead of Revolve. (Hint: 
Sketch two circles and extrude, or use Extruded Boss/Base and then Extruded Cut.) 

3. Practice creating a) a center rectangle, b) a 3 Point rectangle c) a parallelogram. 

4.    Use the command Offset Entities to create the bearings spacer inside diameter. (Hint: 
Offset the spacer’s outside diameter by 0.17 inch.) 

5.     Explain why the best plane for the wheel sketch is the Top plane. Propose an alternative 
and its advantages and disadvantages. 

6. Re-draw the parts modeled in this Lesson using millimeters instead of inches. Use the 
mmPart template and the dimensions in the detail drawing in the Appendix. 

7. It is possible to Extrude Boss/Base one circle or two concentric circles but not three 
circles. Explain why? 

Questions 

1. Explain why the wheel and the tire are each individual parts with separate detail 
drawings. Discuss the advantages and disadvantages of the having only one detail 
drawing for both. 

4. What is the hardness range of polyurethane? 
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Lesson 5 – Modeling Miscellaneous 
Rubber Parts 

5.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Make changes to an existing solid model. 
• Sketching on faces. 
 Explain and use the Dome command. 
 Explain how to toggle between a dome and a dome cavity. 
 Explain and use the command Extruded Cut. 
 Explain and use the Draft On/Off option in Extruded Cut. 

5.2 Introduction 

The truck assembly has two spacers. We will model the first by sketching two concentric circles 
with the command Extruded Boss/Base. 

To create the second spacer, we will edit the FeatureManager design tree to change the 
thickness of the first spacer. It is not necessary to start a new solid model because SolidWorks 
allows the modification of existing models. Remember to save the two models as separate files 
called TopSpacer and BottomSpacer. 

Finally, we will model the Truck Bumper using the command Dome. We will need two 
sequences of PSDF (Plane, Sketch, Dimension and Feature). 

5.3 Modeling the Top Spacer 

The top and bottom spacers have the same cross-sections, but different thickness. 

Step 26: Open a new InchPart document. 

 In drawing SKBD113 in Appendix A, find the best plane to draw the two concentric 
circles that will be extruded to get the doughnut shaped spacers. I should be the Top 
plane. 

 Sketch two concentric circles as shown in drawing SKBD113 in Appendix A and in 
Figure 5.1. 
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 Use Smart Dimension to add the inside 
diameter and the outside diameter in Figure 
5.1. The dimensions can be found in 
drawing SKBD113 in Appendix A. 

 Use Extruded Boss/Base to create the 
thickness for the Top spacer and the Fillet 
command to round the edges. 

 The thickness is found in the spacer 
thickness table in SKBD113. 

 Use a midplane extrusion. Click OK to 
accept. 

Step 27: Use the Fillet command to cut the 90 degree 
edges around the tire. 

 Hold the control key and click each of the edges of the tire, and then click the Fillet 
command on the Features tab in the CommandManager. The input box will show 
Edge1 and Edge2 as the items to fillet. Type the radius of the fillet to add a fillet around 
the edges. The completed spacer is shown in Figure 5.2a. 

 Right-click Material and then click Edit Material. Select Polyurethane rubber as the 
material. 

 Click the arrows to the right side of the Feature/Property/Configuration managers’ 
tabs. This will show the Display Pane. See Figure 5.2b. 

 Select the column under the multicolor ball and click the first line. Click Appearance to 
open the PropertyManager for the part. Click a shade of red you like and then the 
checkmark to accept. 

 Record your name, date, and other information in the Design Journal. 

 Fill the information in the FileProperties form. 

 Save your model as SKD113. 

 

Figure 5.1 – Sketch for TopSpacer 
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Figure 5.2a – TopSpacer 

Changes 
Changes are inevitable in the design process 
because design is a learning experience. As you 
explore alternatives, you learn that some are better 
than others. Thus, the better ideas replace the not-
so-good choices and you have to constantly update 
your model to reflect the latest ideas. Fortunately, 
SolidWorks minimizes the work when we make 
changes. You can make changes in the sketch and 
in the extrude distance. It is also possible to change 
the sketch plane. 
The problem with changes is that there will always be 
a different, or maybe even better, way of 
accomplishing a design goal. This can result in a 
never ending process of “improvements”. At some 
point in time the design must be considered complete 
and ready for manufacture. Always keep in mind that 
“better is the enemy of good enough”. If a design 
solution satisfies the requirements agreed to at the 
beginning of the design, do not change it for the sake 
of a “better design”.  Beware also of “creeping 
requirements”. New requirements cost more and take 
more time. 

 
Figure 5.3b – Display Pane 
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Step 28: To create the Bottom Spacer: 

 Begin with the TopSpacer. 

 Right-click the Extruded Boss/Base feature in the FeatureManager design tree and 
select the Edit Feature icon. 

 Change D1, the thickness of the spacer, to 0.50 inch. 

 Click the check mark to accept. 

 Use Save As in the Main Drop-down Menu to save the new spacer as SKBD115. 

Note: We edited the extrusion Feature to change the length of the extrusion. If we wanted to 
change the diameter of the extrusion we would edit the Sketch. 

5.4 Modeling the Truck Bumper 

Step 29: To create the Truck Bumper, refer to drawing SKBD114 in Appendix A for dimensions: 

  Select the Top Plane and sketch a circle.  

 Dimension the diameter. 

 Use the Extruded Boss/Base command to create a cylinder 0.20 inch long. Use the 
Blind option and the Up direction. Click the check mark to accept. 

 Use the command Rotate View on the View (Has-Up) toolbar to see the bottom 
surface of the cylinder. 

 Click the bottom surface of the cylinder to make it active. 

 Click the InsertFeaturesDome command on the Main Drop-down Menu or click 
the Dome icon on the Features tab in the CommandManager. 

 Type the radius of the dome on the input box. 

 If Show preview has a check mark, you will see a preview of the dome in Figure 5.3. 

 Click the check mark to accept the dome. 
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Step 30:  To create the interior of the part, click the flat surface opposite the dome. 

 Click the Sketch icon on the Sketch tab of the CommandManager. 

 After clicking the Sketch icon you will notice that Offset Entities will change from gray 
to color. This means that it is now available for use. 

 Click Offset Entities. 

 Type 0.10 inch on the input box. 

 The new offset circle is smaller than the original circle. You can use the Reverse 
Direction arrows, if necessary. 

 Click the check mark to accept. 

 Click InsertCutExtrude on the Main Drop-down Menu, or Extruded Cut on the 
Features tab. 

 Use the blind option and type the depth of the Extruded Cut in the drawing. See Figure 
5.4 below and notice that the Extruded Cut stops where the dome starts. 

 Click the Draft On/Off icon and type 5 (degrees) draft. 

 Click the check mark to accept. 

 Use Section View in the View Heads-Up toolbar to verify that the diameter is smaller at 
the end of the extrusion. 

Figure 5.4 – Dome Command 
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Step 31:  To create a dome cavity, click on the surface created by the Extruded Cut to make it 
active. 

 Click the Dome command. 

 Type the value of the inside radius (.18 inch) on the input box. 

 Click the Reverse Direction arrows to create a cavity. See Figure 5.5. 

 Click the check mark to accept. 

 

Figure 5.5 – InsertCut-Extrude 

Figure 5.6 – Dome Cavity 
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Step 32: Make the material rubber and the color to red. Make an appropriate entry in the Design 
Journal and in the Properties form. Save your model as SKBD114.sldprt. The Title and 
Description are Front Bumper. 

Practice Exercises 

1. Model the spacer using Revolve Boss/Base instead of Extruded Boss/Base. 

2. Create models of the parts in this Lesson using millimeters instead of inches. Use the 
mmPart template and the dimensions in the detail drawing in Appendix B. 

Questions 

1. Create engineering working drawings for your bed, naming parts and assemblies? Make 
sketches of the bed assembly and of each of the parts and sub-assemblies. Explain why 
you chose to define each of the parts and assemblies the way you did. Which 
SolidWorks planes you would choose to sketch each of the parts? How would you 
transform the sketches into solid models? 

2. Choose a typical consumer product and describe how you would divide it into parts and 
assemblies. Some examples of products include a bicycle, a tennis racket, an inline 
skate, a ball-point pen or a shoe. On which planes would you create each of the 
SolidWorks sketches? How would you transform those sketches into solid models? 
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Lesson 6 – Editing Parts 

6.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Edit SolidWorks part models. 
 Explain and use the Rollback Bar. 
 Explain why the Wheel Sub-assembly was not created as a single part. 
 Explain and use the feature command Circular Pattern. 

6.2 Introduction 

One of the reasons for the widespread use of CAD software is the increase in productivity that 
can be achieved with their use. Before CAD, making a change required erasing the old 
geometry very carefully to avoid untidiness, and then adding the changes. If the new geometry 
did not fit in the space available, the change could require a new drawing. With SolidWorks, old 
models can be changed and re-used easily. 

6.3 Adding Bumps to the Wheel 

To get good mechanical grip between the wheel and the tire, we will add bumps to the outside 
surface of the wheel (see the Front View in drawing SKBD121). These bumps will prevent the 
tire from slipping around the wheel and will match pockets in the rubber tire (see SKBD122). 

Step 33:  Navigate to file SKBD121.sldprt and Click FileOpen on the Main Pull-down Menu to 
open the document. 

Step 34:  We will use the Rollback Bar as a time machine. If we move the bar up before the 
Chamfer feature (and after Revolve), we can create the bumps before creating the Chamfer.  

 First, move the mouse cursor over the line and it will change into a hand. 

 Click and drag the line to the new location between the Revolve feature and the 
Chamfer feature. 

 The Chamfer feature changes to gray, meaning that it is not active. 

Step 35:  Select the Front Plane as the sketch plane and click the Sketch command on the 
Sketch tab of the CommandManager. 

Step 36:  Use the Rectangle tool to sketch Figure 6.1. 
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 Notice that Inferencing changes the color of the 
circumference to red to indicate that the lower 
left corner of the rectangle is coincident with the 
edge of the wheel. 

 If you cannot sketch a rectangle with the corner 
in the desired location, try Zoom. Sometimes 
lines, circles and other geometric entities cannot 
be made active because they are too small. 

 If Zoom does not work, use Display/Delete 
RelationsAdd Relation on the Sketch tab in 
the CommandManager to make the corner of 
the square coincident with the edge. 

Step 37: Add the dimensions in Figure 6.1 to fully define the 
sketch. 
 You can make the right corner and the circle 

coincident instead of using the dimension 0.250. 

Step 38:  Use Extruded Boss/Base using the Midplane 
option and the length of the bumps in SKBD121 to get Figure 6.2. Notice that the bumps do not 
extend to the edges of the wheel. 

 Figure 6.2 – Wheel Bump Extrusion 

Figure 6.1 – Sketch for the Wheel Bump 
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Step 39:  Next, we will copy the bump into a circular pattern. 

 Click on the Linear PatternCircular Pattern icon in the Features toolbar in the 
CommandManager. The first dialog box is the axis around which the pattern rotates. 

 Click on the dialog box to make it active. 

 Next, click the origin of the part in the center of the wheel. If an axis does not show in the 
options dialog box, it is because Temporary Axes are not visible. 

 To make the axis of rotation visible, click on ViewTemporary Axes on the Main Drop-
down Menu. The origin of the part and axis of rotation can be seen now and can be 
used to create the pattern. 

 Click the input box again to make it active and then the temporary axis at the center of 
the part. This will fill the input box. 

 To create 12 equally spaced repetitions including the original bump, fill all the option 
boxes in the dialog box as shown in Figure 6.3. Notice that there will be 12 bumps 
equally distributed around the outside surface of the cylinder.  

 Click the Feature to Pattern input box and the Extruded Boss/Base feature in the 
FeatureManager design tree. 

 Notice that the FeatureManager design tree moved to the right of the dialog box. 

 Click the + sign to expand the FeatureManager design tree. 

 Click the feature we extruded in Step 37 at the bottom of the design tree. 

 Click the check mark to accept the change and before saving your work, record on the 
Design Journal the date when you added the bumps. 

 Verify that your work was saved as SKBD121. 

 

Figure 6.3 – Preview of the Circular Pattern of Bumps 
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6.4 Configurations 

In Lesson 5 we created two spacers. The Top spacer is 0.38 inch in thickness and the Bottom 
spacer is 0.3125 inch in thickness. Because the two spacers are so similar, SolidWorks allows 
the storing of the model information as variations or configurations of the basic donut design. In 
the following two steps we will create a solid model with two configurations to replace solid 
models SKBD113 and SKBD115. We will call the new solid model SKBD116. 

Step 40: Open SKBD113 (the Top spacer) and create a new configuration. 
 Click the ConfigurationManager Tab (see Item 9 in Figure 1.4). 

 Right-click the first line in the ConfigurationManager tree. 

 This will present the input menu.  

 Type BottomSpacer on the first input box for the Configuration name. 

 Type any appropriate information in the next two input boxes for Description and 
Comments. 

 On the pull-down menu, select Configuration name. 

 Expand Advanced Options and check Suppress operations so that different 
configurations can have different geometry. 

 Click the check-mark to accept. 

Step 41: Rename and change dimensions of configurations. 
 You should have two configurations now. One is called Default and the other 

BottomSpacer. 

 Click slowly two times on the Default configuration. This will allow changing the name. 

 Type TopSpacer to replace Default. 

 Experiment by double-clicking alternately on TopSpacer and BottomSpacer. This will 
alternate between the two. 

 Make active the BottomSpacer by double clicking the new configuration. 

 Click the FeatureManager Tab (see Item 9 in Figure 1.4). 

 Right-click the Extruded Boss/Base feature on the Design tree. 

 Select Edit Feature to show the input for Extruded Boss/Base. 

 Type the new thickness (D1) of 0.50 inch.  

  Page 60 



Lesson 6 – Editing Parts 
Section II – Modeling Simple Parts  Practice Exercises 

 Check “This configuration” to make this thickness unique to the BottomSpacer. 

 Click the check-mark to accept. 

 Return to the ConfigurationManager and double-click on the two configurations to see 
how they change thickness. 

 Save the model as SKBD116 and “Spacers” for Title. 

 
Practice Exercises 

1. Create the part Tire.sldprt with the pockets for the bumps in the wheel. Use the 
dimensions in drawing SKBD122. Hints: Use the following commands, Temporary 
Axes, Linear PatternCircular Pattern on the CommandManager  

2. Modify the skateboard deck to have two configurations. One in which the material is pine 
and the other made of maple. 

Questions 

1. Explain the need for the “bumps” in the wheel and the pockets in the tire. 
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Internet Resources 

CADeducators.com website: http://www.cadeducators.com   

SolidWorks tutorials: http://www.solidworks.com/sw/resources/solidworks-tutorials.htm  

SolidProfessor tutorials: http://www.solidprofessor.com/  
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Lesson 7 – Modeling the Truck Axle 

7.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Model complex parts by breaking them into multiple simple parts. 
    Learn to create a tapered extrusion. 
 Explain how to create sketch planes. 
    Learn to create and explain the command Trim Entities. 
 Explain and use the command InsertAnnotationsCosmetic Thread. 
 Explain and use the Mirror command on the Features tab on the CommandManager. 
 Explain and use Multibodies. 

7.2 Introduction 

Complex parts must be planned. They are created by combining simple solids. In many complex 
parts, it is necessary to create new sketch planes. 

7.3 Modeling the Truck Axle 

The truck is a combination of four solid bodies: 

1) the axle, 

2) a seat for the two rubber spacers, 

3) a reinforcing rib to join the axle and the seat, and 

4) a tapered pivot. 

See drawing SKBD112 in Appendix A for reference. 

Step 42:  Create the middle shaft of the axle. 

 Select the Right plane, click the Sketch command on the Sketch tab of the 
CommandManager and then click the Circle command.  

 Use Smart Dimension to make the diameter 0.63 inch. 
 
 Use Extruded Boss/Base to create a cylinder 2.5 inches long. Use the Blind extrusion 

option.  
 
 Click the check mark to accept. 
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Step 43:  Create the smaller diameter section of the axle. 

 Click one of the end faces of the cylinder. 

 In the View Heads-Up toolbar click View OrientationNormal To. 

 Click the surface to make it active. 

 Click the Sketch command in the Sketch tab of the CommandManager. 

 Click the Circle command on the Sketch tab of the CommandManager. 

 Make the diameter 0.25 inch.  

 Use Extruded Boss/Base to extrude another cylinder to a length of 1.00 inch. Use the 
Blind option.  

 Click the check mark to accept. 

 Click the Mirror command on the Features tab of the CommandManager. This will 
mirror the ½ axle we have into the full length. 

 Click the axle to fill the Bodies to Mirror input box. The ½ axle consists of the two 
merged cylinders created thus far. 

 The mirror plane is the Right plane 

 Click the check mark to accept. 

Step 44:  Create the threaded tip of the axle. 

 Select the end face of the second cylinder you created as the new sketch plane. 

 Click View OrientationNormal To in the View (Heads-Up) toolbar. 

 Click the edge of the circle to make it active. 

 Click the command Sketch on the Sketch tab of the CommandManager.  

 Click Convert Entities to add the edge of the surface to the new sketch. 

 Click the check mark to accept. 

 Click Extruded Boss/Base and select Blind. Type 0.75 inch for the length D1. 

 Uncheck Merge result on the properties menu. 

 Click the check mark to accept. 

 Notice that a new folder named Solid Bodies is now visible in the FeatureManager 
design tree. Open the folder and verify that you have two bodies. This SolidWorks 
Multibody model was created because we unchecked Merge result when we created 
the new feature. 

 Select the circular surface of the new cylinder and click InsertAnnotationsCosmetic 
Thread. Select ANSI Inch in the Standard input box. Select ¼-28 UNF thread in the Size 
input box and Up to next for end condition. 
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 UNC means that this is a coarse thread, the most commonly used. Fine thread (UNF) is 
used for high stress applications. UNF requires more “turns” to travel a distance compared 
to UNC and requires a little more labor to use. 

 Click the check mark to accept.  

Step 45:  Change the appearance of the surface to simulate threads. 

 Right-click the surface of the new cylinder body. 

 Click the Appearances icon (this is the 4-color ball). 

 Click Face. The PropertyMenu appears at the left side of the screen and the 
Appearances/Scenes appears on the right side. 

 Expand Appearances (color) on the right-hand menu. 

 Expand Miscellaneous. 

 Click Pattern. 

 Click the screw thread pattern. 

 Click the Mapping tab on the left hand menu. 

 Select Axis direction: XZ on the pull-down menu and Big mapping size. You may 
need to Zoom on the thread to see the difference. 

 Experiment with Rotation. 

 Click the Mirror command again to duplicate the new body and the threads on the opposite 
side. 

Step 46:  Next, Mirror the new body across the Right plane. 

 Click InsertMirror/PatternMirror on the Main Pull-down Menu, or click Linear 
PatternMirror on the Feature tab of the CommandManager. 

 Select the Right Plane as the Mirror Face/Plane and the latest extrusions as the 
Features to Mirror. See Figure 7.1. 

 Click the check mark to accept. 

 Notice that there are now three bodies in the Solids folder. 

 It is important to know that the Mirror command works with Features or Bodies, but 
they have to be duplicated in separate steps. Mirror will not work with Features and 
Bodies at the same time. 
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Step 47:  Next, we will create a seat for the rubber spacers. 

 Select the top plane and sketch a circle with the dimensions shown in Figure 7.2. (Pick 
the Top Plane, click Sketch in the Sketch tab and then click Circle). 

 Warning: The circle 
must overlap with the 
axle cylinder. If the 
circle is tangent or 
detached, the two 
solids will not merge 
and you will get 
another body in your 
multibody model. 

 Add a vertical relation 
between the center of 
the circle and the 
origin to keep them 
aligned. Use the 
command 
Display/Delete 
RelationAdd Relation in the Sketch tab. 

 Extrude the circle using the Mid Plane option as shown in Figure 7.3. The extrusion 
distance is 0.38 inch. 

Figure 7.1 – Truck Axle 

Figure 7.2 – Seat for the Rubber Spacers 
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Step 48:  Create the truck pivot. 

 First, we will create a sketch plane rotated 32 degrees from the Front Plane. 

 Click InsertReference GeometryPlane. 

 For the First Reference select the Front Plane from the FeatureManager design tree, 
which moved to the right of the input dialog. 

 Click the angle icon and type 32degrees. 

 For the Second Reference click the axis of the shaft. 

 If the axis of the shaft is not visible, click ViewTemporary Axes on the Main Drop-
down Menu. The axis is now visible as a dashed line. Click the line. 

 Click the check mark to accept. Remember that planes in SolidWorks are infinite. The 
location of the plane that appears is not important. 

Figure 7.3 – Extruded Seat 
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 The new plane created is rotated from 
the Front Plane 32 degrees using the 
shaft axis for rotation. See Figure 7.4. 

Step 49:  Create another plane parallel to the 
rotated plane. 

 Click InsertReference Geometry 
Plane. 

 For the First Reference click the 
plane that we created in the previous 
step. 

 Click the Offset distance icon to 
create a parallel plane 1.06 inches 
away. 

 Click the check mark. 

 Notice that rotation requires two 
references (the plane to be rotated 
and the axis of rotation) while offset needs only one reference (the offset). 

Step 50:  Create the base of the dome at the tip of the truck pivot. 

 Verify that the new offset plane is active. Its color is different from other visible planes. 

 In the Heads-up View toolbar, click on View Orientation and select Normal To. The 
view can be rotated 180 degrees to the opposite side by clicking View 
OrientationNormal To a 
second time. 

 Click the Sketch icon on the 
Sketch tab of the 
CommandManager. Click the 
Circle command and draw a 
circle on the offset plane as 
shown in Figure 7.5. The 
diameter is 0.4 inches. 

 The center of the circle is 
aligned with the origin of the 
axle. 

 Notice that the origin is not on 
the offset plane, but if you 
move the cursor over the 
origin, Inferencing will show the location of the point in the offset plane that is aligned 
with the origin. If the blue coordinates are not visible, click View on the Main Pull-down 
Menu and verify that Origins is active. 

Figure 7.4 – Front, Rotated and Parallel Planes 

Figure 7.5 – Sketch for Pivot Tip 
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 Also notice that the diameter of the circle is 0.4 inch because it must match the dome of 
radius 0.2 inch. 

 With the sketch active on the design tree, use Extruded Boss/Base to create the pivot. 
Use the Draft On/Off option and type 5 degrees. Select Up to Surface for the end 
condition. See Figure 7.6. If necessary, you can toggle the draft to match the Figure. 

 Click the check mark to accept. 

 Figure 7.6 – Tapered Extrusion for Pivot 
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Step 51:  Create a dome at the 
end of the pivot. 

 Select the surface at 
the end of the pivot 
as the sketch 
surface. 

 Click Insert 
FeaturesDome. 
The radius is 0.20 
inch. See Figure 7.7. 

For the stiffener, we will 
sketch in the Top plane. 

Step 52:  Create the stiffener. 

 Click Top Plane and 
sketch the triangle in 
Figure 7.8. 

 Pay attention to the 
sketch relations and 
angles to achieve a fully 
defined sketch. 

 Use Extruded 
Boss/Base. Select Mid 
Plane and type a 
thickness distance D1 
of 0.125 inch. 

 Please note that if we 
use 2 decimal places in 
the drawing the number 
will show as 0.13. 

Step 53:  Create the top pocket for the rubber spacers. 

 Sketch a circle1 inch in diameter as shown in Figure 7.9. 

 Use Extruded Cut to create a pocket for the rubber spacer. The depth is 0.125 inch. 

 

Figure 7.7 – Pivot Dome 

Figure 7.8 – Sketch for Stiffener 
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Step 54: Use the Mirror command in the 
Features toolbar to create the second 
pocket in the opposite surface. See Figure 
7.10. The mirror plane is the Top Plane. 

 

Step 55:  Sketch a slot for the bolt that 
attaches the truck to the skateboard. 

 The sketch is shown in Figure 7.11. 
Use the Centerpoint Straight Slot 
on the Sketch tab to create the 
sketch. 

 Use Extruded Cut to create the slot.  

Step 56: The Truck Axle is complete. Save your work as SKBD112. Complete the appropriate 
entries in the Design journal and in the Properties form. 

 

Figure 7.10 – Spacer Pockets 

Figure 7.9 – Sketch for Pocket 

Figure 7.11 – Sketch for Slot 
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Trim Entities 
 

The command Trim Entities can be used to cut a portion of a line or curve. You can 
find the icon in the Sketch tab of the CommandManager. For example, the sketch on 
the left can be generated from the sketch on the right by using the command Trim 
Entities Trim to closest to cut the segments that are not needed.  
 

          

 

Extend Entities 
 

You can find the command Extend Entities in the pull-down menu under Trim 
Entities in the Sketch tab of the CommandManager. It can be used to extend a line 
or curve to meet another element (point, line or curve). It cannot be used to just make 
the line or curve longer into empty space. For example, the figure on the left can 
become the figure on the right with the use of this command to extend the vertical 
line. 
                                                                                                      

                             
                                                                                                     

  Page 74 



Lesson 7 – Modeling the Truck Axle 
Section III – Modeling Complex Parts  Practice Exercises 

Practice Exercises 

1. Re-draw the Truck Axle modeled in this Lesson using millimeters instead of inches. Use 
the mmPart template and the dimensions in the detail drawing in Appendix B. 

2. Create the pivot using Lofted Boss/Base instead of the tapered Extrude Boss/Base. 

Questions 

1. Give one example of a complex part and the strategy you would use to create a model of 
the part. 

2. What manufacturing process and material do you recommend for the truck axle? 

References 

SolidWorks Bible – by Matt Lombard, John Wiley and Sons, Indianapolis, IN, US 

SolidWorks Office Training Manual – by SolidWorks Corporation, Waltham, Massachusetts, US 

SolidWorks 2014 Short and Simple – by OnlineInstructor.org 

Introduction to Using SoildWorks – by W.E. Howard and J.C. Musto, McGraw Hill, New York, 
NY, US 

Videos from SolidProfessor Core Concepts for Parts and Assemblies 
• Planes 
• Trim Tools 
• Mirroring Bodies 
• Troubleshooting Parts – Introduction 
• Troubleshooting Sketches 
• Troubleshooting Features 

Videos from SolidProfessor Advanced Parts 
• Dome 
• Multibody Parts 
• Creating Multiple Bodies 

Internet Resources 

CADeducators.com website: http://www.cadeducators.com   

SolidWorks tutorials: http://www.solidworks.com/sw/resources/solidworks-tutorials.htm  

SolidProfessor tutorials: http://www.solidprofessor.com/ 
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Lesson 8 – Modeling the Truck Base 

8.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Explain how to link dimensions. 
 Explain how to use equations for dimensions. 
• Explain how to use the command Extruded Boss/Base when the extrusion is offset 

from the sketching plane. 
• Explain how to extrude in two directions simultaneously. 

8.2 Introduction 

It is possible to link dimensions and also to use equations to define distances. In this chapter we 
will learn both as we create the base of the skateboard truck. We will also learn that the Extrude 
Boss/Base command does not have to start from the sketching plane. 

8.3 Modeling the Truck Base 

The truck base is a combination of 
three features: the rectangular base, 
a cylinder extrusion for the spacers 
and a raised Pivot pocket with a 
socket hole for the truck pivot. We 
will first create the base, then the 
cylinder extrusion and finally the 
Pivot pocket. 

Step 57:  Create the rectangular base. 

 Open a part document and 
select the Inch template. 

 Sketch on the Top Plane, 
the rectangle in Figure 8.1. 

 Click Extruded Boss/Base, 
select Blind a thickness of 
1/8 inch in the down direction 
so the origin is on the top 
surface. Figure 8.1 – Sketch for Truck Base 
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Step 58:  Create the top-right corner hole. 

 Select the top surface of the 
base to make it active. 

 Click Circle on the Sketch 
tab and sketch a circle on 
the top-right corner of the 
plate. 

 Click Smart Dimension 
and then click the diameter 
of the circle. 

 Type “0.25” on the input 
box.  

 In your keyboard, press 
Enter two times to accept 
the value (or the check 
mark to accept the 
equation). Notice that when 
you press “Enter” the first 
time SolidWorks creates an 
equation. 

 Enter the other locating 
dimensions by typing “=” 
and then clicking the 
diameter of the circle.  

 Note: We are following the 
rule of thumb that the center 
of the hole should be a minimum of one diameter from the edges of the plate. This is a 
design rule of thumb that prevents stress concentration and possible failure if the hole is 
too close to the edge. You can use a larger separation. In addition, the bolt heads should 
not extend past the edge of the plate and we can make the distance larger. 

Step 59:  Add a second hole at the bottom-right corner of the plate. 

 Click the Circle command again and draw another circle in the lower corner of the Base. 

 Click Smart Dimension and then click the circumference of the new circle.  

 In the input box type “=”. 

 Click the diameter of the previous circle. This will enter the name of the previous circle 
into the input box. Now the two diameters are the same. 

 Enter the other locating dimensions in the same fashion, typing “=” and then clicking the 
equivalent dimension in the first circle. 

 Your sketch should look like Figure 8.2. The ∑ indicates that we have equations for the 
dimensions. 

Figure 8.2 – Corner Holes 
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 Click the check mark to accept the sketch. 

 
Step 60:  Use the Mirror Entities command on the Sketch tab to create the other two holes. 

 Click the pull-down menu for the line command and select the centerline. 

 Sketch a vertical centerline from the origin. The length of the line is not important. You 
will notice that the end point is blue, or undefined. You can constrain it by using Smart 
Dimension, or by clicking on the point, which opens the PropertyManager, and 
selecting Fix in Add Relations. 

 Click Mirror Entities on the Sketch tab. 

 For Entities to mirror, select the two holes. 

 For Mirror about, select the centerline. 

 Click the check mark to accept the Mirror command. 

 Click Extruded Cut on the Features menu. Select Through All or Up to Next. 

 Click the check mark to accept. 

 

 

 

Fix Relation 
The “Fix” relation can be used to fix the location of the points in a spline. They are also useful 
to fix the end points in a construction line that will be used for the mirror or sweep 
commands. They should not be used instead of proper modeling using dimensions and 
Sketch Relations. 

Sketch Clutter 
It is possible to have too much information in your sketch. Figure 8.2, for example shows 
dimensions and sketch relations. To turn-off the sketch relations, use ViewSketch 
relations on the Main Drop-down Menu to toggle on and off. Other useful toggles are 
ViewTemporary Axis and ViewHide All Types. 

Changing Linked Values and Equations 
Links can be broken and equations can be changed. Double click on the number and use the 
smart dimension pull-down menu to make changes. 
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Step 61:  The cylinder extrusion with the pocket for the bottom 
spacer is tilted at an angle from the horizontal surface of the 
base. First, we must create a sketch plane. Then, we will 
sketch a circle and extrude the cylinder. 

 Select the top surface of the base for sketching and 
sketch a centerline as shown in Figure 8.3. The line 
passes though the origin (a coincident relation). If 
the origin is not visible, click View on the Main Pull-
down Menu and click the Origins icon. 

 Click the pencil to accept the sketch. 

 To create a new plane by rotating the top surface 
about the centerline, first click the Top surface of the 
base. 

 Click InsertReference GeometryPlane and 
enter the top surface and the centerline we created 
in the previous step in the input boxes. This will rotate the top surface with the centerline 
as the axis of rotation. Rotate the top surface 5 degrees clockwise. See Figure 8.4. 

 Experiment with the Flip option to see how it changes the new plane. Your new plane 
should match Figure 8.4. 

 Click the check mark to accept. 

Step 62: Select the plane we created in the previous step and sketch a circle with the center in the 
origin and a diameter of 1.25 inch. 

Step 63: Extrude the cylinder in both directions as shown in Figure 8.4. Click the check mark to 
accept. 

 In one direction the extrusion is Blind and in the other it is Up To Surface. The Blind 
extrusion is 1.00 inch. For Face/Plane click the Top surface of the Base. 

 Notice the 1 degree draft on the extrusion. 

Figure 8.3 – Axis of Rotation for Top 
Plane 
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Step 64:  Create the pocket for the rubber spacer (Part SKBD115). 

 Select the top surface of the newly created cylinder for sketching. 

 In the CommandManagerSketch toolbar click on Offset Entities. See Figure 8.5.  

 In the Offset Entities dialog box, type 0.120 inch offset. 

 Click the check mark to accept. 

 Click Extruded Cut in the Features toolbar of the CommandManager. See Figure 8.6. 
The depth of the pocket is 0.125 inch. 

Figure 8.4 – Truck Base 
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Step 65: Select the surface of the pocket and sketch a circle 3/8 inch in diameter with the center 
coincident with the origin, and click Extruded Cut using Through All. Remember to use Smart 
Dimensions to enter the diameter and add a collinear relation if needed. See Figure 8.7. This is 
for the kingpin that will attach the Truck Base to the Deck. 

Figure 8.5 – Offset Command 

Figure 8.6 – Extruded Cut Pocket 
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Step 66: Select the surface of the pocket again 
and sketch the square shown in Figure 8.8. 
The sides of the square are 0.75 inch and it 
is centered on the origin.  

 Use the Center Rectangle option. 

Step 67: Click on the Extruded Cut icon in the 
Features toolbar and select the options in 
the dialog box on Figure 8.9. 

 In Figure 8.9, notice that the pocket 
starts at an offset of 0.20 inch from the 
sketch surface and ends with the Up To 
Next end condition in Direction 1. 

 Click the check mark to accept. 

Figure 8.7 – Hole for Bolt 

Figure 8.8 – Rectangle Sketch for Bottom Pocket 
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Step 68:  To create a pocket for the Truck Pivot, we will start by creating a plane at a 128 degrees 
tilt from the top face of the base. Then we will sketch a cross-section at the end face of the base 
and then extrude the cross-section up to the plane created. See Figure 8.10. 

 Select the top face of the base as the sketch plane. 

 Create a centerline across the face of the base at a distance of one inch from the edge 
of the base. See Figure 8.10. 

 Click the Pencil to accept the sketched centerline. 

 Next, create a new plane by rotating the top surface of the base 128 degrees clockwise. 
See Figure 8.10. Use the command InsertReference GeometryPlane with the top 
face of the Base as the First Reference and the centerline created earlier as the 
Second Reference. 

 Click the check mark to accept. 

Figure 8.9 – Bottom Pocket 
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Step 69:  Sketch the cross section at the end of the Truck Base. See Figure 8.11. 

 Select the vertical surface on the back of the rectangular base to make it active. 

 Sketch the cross section shown in Figure 8.11. Notice that the center of the arc and the 
origin have a vertical relation. Also, the end of the arc and the straight lines are tangent. 

 Use the commands Smart Dimensions and Display/Delete RelationsAdd Relation 
to add the relations shown. The order you use is important. If the sketch is distorted by a 
command or relation, click Undo and try another sequence. 

 

Figure 8.10 – Extrusion for the Truck Pivot Pocket 

Figure 8.11 – Sketch for the Back of the Pivot Pocket 
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Step 70: Extrude the cross-section from the sketch plane to the plane that was rotated earlier to 
128 degrees. The Extruded Boss/Base input panel is shown in Figure 8.12. Notice that the 
extrusion is Up To Surface and the surface is the plane created earlier. 

 

 
 

Step 71:  Create a dome cavity for the Truck Pivot. 

Figure 8.12 – Extrusion of the Pivot Pocket 
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 Select the Front face of the 
extrusion created on Step 
70 and click Circle to sketch 
the circle shown in Figure 
8.13. 

 Use the Smart Dimensions 
command to get the sketch.  

 If your sketch is not fully 
defined (black), Use Add 
Relation and Vertical to 
align the center of the circle 
and the center of the base. 

 Use Extruded Cut to a 
depth of 0.06 inch. 

 Click the check mark to 
accept. 

 Select the surface at the 
bottom of the Extruded Cut as the sketch plane. 

 Use the InsertFeatures Dome command. The distance is 0.35 inch. 

 If necessary, toggle the Reverse Direction icon to create a cavity instead of a dome. 
See Figure 8.14. 

 Click Section View to check your work. Verify that the dome does not cut the bottom 
surface of the base. 

Step 72:  Use the Fillet command to 
create the 1/8 inch rounded corners 
on the base and a 0.03 inch 
chamfer around the top surface of 
the base. The edge of the seat for 
the bottom spacer are also 
chamfered 0.03 inch. See Figure 
8.14.  

Step 73:  Calculate the volume of 
material needed to make this part 
and its mass. 

 Right-click Material in the 
FeatureManager design 
tree.  

 Click on Edit Material. 

Figure 8.13 – Sketch for the Dome 

Figure 8.14 – Truck Base Model 
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 Find and highlight die-cast Zinc alloy AC43A. 

 Click to Apply and then click Close 

 Click on the Evaluate tab in the CommandManager and then click Mass Properties. 

Step 74:  Document your design by filling the Design journal and the Properties form. Record the 
volume and weight of the part. The material is die-cast Zinc. 

 Finally, save the part as SKBD111.sldprt. 

 If necessary click View in the Main Pull-down Menu and then click Hide All Types so 
the planes, axis and other confusing entities are not visible. 
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Evaluate, Measure and Mass Properties 
 

The Evaluate tab in the CommandManager allows us to measure and calculate mass and section 
properties of parts and assemblies. In the case of mass properties, SolidWorks needs to know which 
material(s) are used. To choose a material, right-click the Material icon on the FeatureManager 
design tree to get 10 common choices. You can get additional choices by clicking on Edit Material. 
Custom Materials are used for proprietary alloys or heat treatments that have properties different from 
published values.  
 
By clicking the Mass Properties icon in the Evaluate tab of the CommandManager, we get the 
volume, mass, density and surface area of a part or assembly. We can also get the center of mass and 
the moment of inertia. An example is shown below. 
 

.  
 

With the Measure tool it is possible to obtain diameter, length and distance between two points. 
 
Section Properties will calculate the properties of a cross-section instead of the properties of the part 
calculated earlier. 
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Practice Exercises 

1. Re-draw the Truck Base modeled in this Lesson using millimeters instead of inches. Use 
the mmPart template and the dimensions in the detail drawing in Appendix A. 

2.    Explain the options you have when using Extrude Boss/Base for: 1) start of the 
extrusion (From), 2) Direction 1 and 3) Thin Feature. 

Questions 

1. Compare aluminum and zinc as materials for manufacturing the Axle and the Base. 
What are the relative advantages of each material? Which one would you recommend? 

2.    Verify that the head of the screw used on Figure 8.2 will not exceed the edges of the 
base. 

References 

SolidWorks Bible – by Matt Lombard, John Wiley and Sons, Indianapolis, IN, US 

SolidWorks Office Training Manual – by SolidWorks Corporation, Waltham, Massachusetts, US 

SolidWorks 2014 Short and Simple – by OnlineInstructor.org 

Introduction to Using SoildWorks – by W.E. Howard and J.C. Musto, McGraw Hill, New York, 
NY, US 
 
Videos from SolidProfessor 3D Skills Core Concepts for Parts and Assemblies 

• Planes 2 
• Measure 
• Materials 
• Mass Properties 

Videos from SolidProfessor Advanced Parts 
• SketchXpert 
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Internet Resources 

CADeducators.com website: http://www.cadeducators.com   

SolidWorks tutorials: http://www.solidworks.com/sw/resources/solidworks-tutorials.htm  

SolidProfessor tutorials: http://www.solidprofessor.com/
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Lesson 9 – Importing Models from the 
Internet 

9.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Find models of mechanical parts in Design Library, Toolbox and in the Internet, and 

import them into SolidWorks. 
 Import models from other CAD software using IGES, STEP and other neutral file 

translators. 
 Use JPEG, TIF, VRML and other common file structures in SolidWorks. 

9.2 Introduction 

The ability to import and re-use models is one of the most useful capabilities of CAD software. 
Many manufacturers and suppliers of bearings, fasteners, actuators and other hardware have 
their catalogs on the Internet and you can download 3D models of their products. You can also 
re-use your old models and those of your co-workers. Many companies have libraries of 
commonly used parts and assemblies for re-use. 

9.3 Importing from Toolbox 

SolidWorks includes various libraries of components 
for re-use. One of them is the Toolbox. Although the 
primary use of Toolbox is to introduce hardware 
components into Assemblies, it can also be used to 
create parts when purchased hardware is modified. 
The modified purchased hardware must have a 
drawing and, hence, a part number. In this section, we 
will import a bearing and in a latter lesson we will 
make a drawing.  

Step 75:  To make the toolbox available, click 
ToolsAdd-ins on the Main Drop-down Menu or 
click OptionsAdd In in the Quick Access Toolbar 
to get the menu in Figure 9.1. Verify that Toolbox and 
Toolbox Browser have a check mark. 

Step 76: Next, in the Task Pane expand Design 
LibraryToolboxANSI InchBearingsRoller Bearings. See Figure 9.2. 

Figure 9.1 – Tools Add-Ins 
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 In the Roller Bearings folder, right-click on the needle roller bearings and select Create Part. 

 Select bearing 14NIU15, which is ½ inch thick with 0.875 inch outside diameter and 0.25 
inch bore. Select the Detailed Display in the pull-down menu. In the Parts Number input box 
type SKBD123. 

 Save the part for future use. Call it SKBD123. 

 

9.4 Importing from the Internet 

Another source of models is the Internet. SolidWorks maintains a library of free models at 
http://www.3dcontentcentral.com/3DContentCentral/ . The models are contributed by 
manufacturers that hope to sell you the components that you download. You need to join to 
download from this website, but there is no charge for joining or downloading models. 

Step 77:  Login to 3DContentCentral and select a Nylock self-locking nut. Follow the instructions to 
download and save your model for future use. 

Figure 9.2 – Toolbox Menu 
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9.5 Importing Standard Fasteners 

Fasteners are available from either Toolbox or from the Internet on 3DContentCentral. 

9.6 Importing and Exporting IGES and STEP Files 

IGES and STEP are popular formats for CAD. They are open standards or neutral files that 
many CAD programs support. They can be used to transfer models between CAD systems. The 
process is not perfect, unfortunately, and some information is always lost in the translation. 
Some proprietary translators claim to transfer more complete information and to have a lower 
error rate than the open standards. 

Step 78: To import or export models using one of these neutral files, select the appropriate File 
Type when opening or saving your model as shown in Figure 9.3. 

 

9.7 Importing an Image for the Background 

We can add a background to a SolidWorks part or assembly. The combination can be used in a 
marketing brochure or maintenance manual. In this section we will add a background to the 
skateboard deck. We will import an image in the TIFF format. 

Step 79:  To insert a picture in a SolidWorks model, right click in the Graphics Area and select 
Edit Scene. 

Figure 9.3 – File Format Options 
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 On the input Background, select one of the options available: color, gradient, image or 
use environment. 

 For Image, Browse to the image you wish to use. One source of images is Google.com, 
or use one of the background images provided by SolidWorks.  

 Check Stretch image to fit SolidWorks window. 

 Click the check mark to accept and save your work. 

Step 80: The background can be removed by right-clicking the Graphics Area, then clicking Edit 
Scene and selecting None on the Background pull-down menu. 

 

 

Figure 9.4 – Adding a Background to the Solid Model 
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Practice Exercises 

1. Import the screws needed in the skateboard assembly. You will need eight flathead 
screws and two hex head screws. They can be imported from the Toolbox, from 
SolidWorks 3D Content Central, or from a manufacturer’s catalog on the Internet. 
Consult the assembly drawing in Appendix A for the size. 

Questions 

1. Find three or more websites where you can find SolidWorks models of commercial 
components. 

References 

SolidWorks Bible – by Matt Lombard, John Wiley and Sons, Indianapolis, IN, US 

SolidWorks Office Training Manual – by SolidWorks Corporation, Waltham, Massachusetts, US 

SolidWorks 2014 Short and Simple – by OnlineInstructor.org 

Introduction to Using SoildWorks – by W.E. Howard and J.C. Musto, McGraw Hill, New York, 
NY, US 
 
Videos from SolidProfessor Toolbox and Design Library 

• Toolbox Overview 
• Setting Up/Adding In the Toolbox 
• Inserting Toolbox Components 
• Design Library Introduction 

Internet Resources 

CADeducators.com website: http://www.cadeducators.com 

SolidWorks models for download: http://www.3dcontentcentral.com/3dcontentcentral/ 

Popular CAD models for download: http://grabcad.com/library/software/solidworks 

Supliers CAD models for download: http://cad.thomasnet.com/cadmodels.html  

CAD Models for download: http://b2b.partcommunity.com/community/ 
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Lesson 10 – Creating Assemblies and 
Sub-Assemblies 

10.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Customize SolidWorks by creating an assembly template. 
 Explain and create assemblies and sub-assemblies. 
 Apply assembly mates. 
 Explain and use the Hide Component and Change Transparency commands. 

10.2 Introduction 

When we open a new assembly document, the software activates all the commands needed to 
assemble two or more parts that were modeled previously. Most of these commands are 
included in the Assembly toolbar. They include commands to move and rotate the individual 
parts or the whole assembly. The Mate command can establish a relationship between different 
parts. Some examples of Mate between parts are concentric, parallel and coincident. Most are 
equivalent to the Sketch Relations studied before, with the exception that they are used with 
parts instead of lines. 

In this Lesson, first we will customize SolidWorks by creating a template that we can use with 
assemblies. Next, we will create the tire and wheel sub-assembly and then the truck sub-
assembly. Before creating this assembly, you must create the tire with the pockets that will 
match the bumps on the wheel (see Practice Exercise 2 in Lesson 6 and drawing SKBD122 on 
Appendix A). Finally, we will learn to explode an assembly and to check for interference. 

10.3 Creating the Assembly Template 

To create the assembly template, open a new document and select an Assembly document. 
The only critical option to be selected is the units that will be used, inches or millimeters. We will 
verify that we work with inches and that the Design Journal is visible. We will accept all other 
default options. 

Step 81:  Click Options on the Quick Access Toolbar or ToolsOptions on the Main Pull-down 
Menu. 

 Select the System Options tab. 
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 Click FeatureManager and verify that the pull-down menu for Design Binder says 

Show. 

 Select the Document Properties tab and click Units to get Figure 10.1. 

 Verify that the selection is IPS (inch, pound, second). 

 Click OK. 

 In FileProperties, create the following Custom Properties: 1) Description (leave 
column 3 blank), 2) Weight (select SW-Mass in column 3), Material (type “- -“ or “NOT 
APPLICABLE” in column 3) and Finish (type “- -“ or “NOT APPLICABLE” in column 3). 

 Save the inch assembly template as InchAssembly.asmdot. 

 Figure 10.1 – ToolsOptions 
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10.4 The Tire and Wheel Sub-Assembly 

The first part introduced to an assembly will remain fixed. Subsequent parts added to the 
assembly can move relative to the fixed part. It is important to plan which part should be 
introduced first. For the wheel sub-assembly we will start with the wheel. 

Step 82:  Open a new document and select the InchAssembly template. 

 The input menu will ask you what part you want to add. Browse through your saved 
parts until you find the skateboard wheel. 

 Click to select the wheel (SKBD121) and then click Open. 

 Move the cursor to the location where you want to locate the wheel. Remember that 
once the wheel is positioned it will not move. 

 To make the wheel coincident with the origin, click the check mark. If the origin is not 
visible, click ViewOrigins on the Main Drop-down Menu. See Figure 10.2. 

 Figure 10.2 – Adding the Wheel to the Assembly 
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Step 83:  Next, add the tire to the assembly. Click Insert Components in the CommandManager 
or select InsertComponentExisting Part on the Main Drop-down Menu. 

 Browse to the tire model (SKBD122), click to select and click OK to bring the tire to the 
graphics area. See Figure 10.3. 

 Drag and release the tire on the graphics area. 

 You have two options to mate the two parts. The quick and easy option is to click the 
check mark to make the axis of the tire and axis of the wheel coincident. This will work if 
the bumps and pockets match exactly. The more complex approach is explained in the 
next step. 

 Drag and drop the tire to one side of the wheel. 

Assemblies 
Products, devices and structures are usually assemblies of parts. The reason for breaking your design 
into parts is to facilitate manufacturing. Each part is made of a different material or manufacturing 
process. Parts are typically manufactured and handled separately and come together at assembly. The 
SolidWorks assembly model can be used to create an assembly drawing that will help the assembler. 
In addition, the SolidWorks assembly can be used to verify that parts do not have interferences and 
that mechanisms will work as expected. If used, this capability can reduce or entirely eliminate errors. 
Sub-assemblies are used to facilitate assembly. For example, in our skateboard the wheels and tires 
are assembled together during manufacture by casting the rubber compound around the wheel. The 
result is a tire and wheel sub-assembly that for all practical purposes can be treated as a single part. 
Another example of a sub-assembly in the skateboard is the truck sub-assembly consisting of the 
wheels, tires and truck. In the automobile industry, engines are assembled and tested independently 
before they are added to the automobile frame at final assembly. 
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Step 84:  To achieve the correct orientation between the two parts, we will use Assembly Mates. 

 First, we will make the wheel and the tire Concentric. Click the command Mate on the 
CommandManager toolbar and click the inner rim of the tire and the outside edge of the 
wheel. Select Concentric on the Standard Mates panel. See Figure 10.4. 

 Notice that the wheel will not move if you click and drag. It is fixed. If you click and drag 
the tire, it will move only along the axis. 

 Open the FeatureManager design tree (to the right of the input panel) and notice, that 
the assembly design tree is composed of the parts included in the assembly. If you click 
the + sign you can see each part’s FeatureManager design tree and the steps that 
created each part.  

 At the end of the design tree you will find the Mates Folder. If you open the Mates Folder 
you will see the mates used to create your assembly. If you right click a mate and select 
Edit Feature, you can change to another type of mate. 

Figure 10.3 – Adding the Tire to the Assembly 
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 Next, select the flat surface of one of the wheel bumps and the equivalent surface in the 
tire and make them Parallel. 

 Finally, make the face of the wheel and the side face of the tire Coincident. 

 Check your work using the Section View icon on the View (Heads-Up) toolbar or 
select Display StyleWireframe or Hidden Lines Visible on the View (Heads-Up) 
toolbar. 

 
Step 85:  Add the bearings. The bearings can be added clicking Insert Component or clicking 

Design LibraryToolbox. 

 To add the bearings using Insert Component, first click the icon on the 
CommandManager. 

 Browse to the Bearing model (optional SKBD123) created in Step 76.  

 Import the model into the assembly. 

 Make the diameters concentric and the two faces that touch coincident. 

 
Adding the bearings importing directly from Toolbox. 

 To add the second bearing importing directly from the Toolbox, click Design 
LibraryToolboxANSI InchBearingsRoller Bearings on the Task pane and 
click and drag the needle roller bearing to its position on the wheel.  

 Release the mouse button. 

Figure 10.4 – Selecting Concentric Mate 
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 Press the Escape key on your keyboard to stop adding bearings. 
 

 Adding the second bearing using the command Mirror Component. 

 Another way of adding a second bearing is to click Linear ComponentsMirror 
components. This will copy the bearing to the other side. 

 Check your work using the Section View, the Wireframe or the Hidden Lines Visible 
commands. 

 Add the appropriate information to the Design journal and to the Properties form. 

 Save the model as SKBD120.sldasm. 

Practice Exercises 

1. Create a millimeter assembly template. Save it as mmAssembly.asmdot. 

2. Create the Truck Sub-Assembly drawing SKBD110 in Appendix A. (Hint: Use the 
following assembly order: BaseBottom spacerFront bumperTruck axleTop 
spacer) 

3. Create the top-level skateboard assembly drawing SKBD100 in Appendix A. (Hint: Use 
Toolbox for the hardware, i.e. the screws and nuts.) 

4. Describe the differences in the FeatureManager design tree for parts and assemblies.  

Questions 

1. Describe the advantages and disadvantages of using sub-assemblies in your design. 

2. List one sub-assembly in a typical automobile. 
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Introduction to Using SoildWorks – by W.E. Howard and J.C. Musto, McGraw Hill, New York, 
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• Starting an Assembly 
• Inserting Components 
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Lesson 11 – Detecting Interference, 
Editing and Exploding the 
Assembly and Creating 
Multiple  Assembly 
Configurations 

11.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Check an assembly for interferences and detect collisions 
 Explain and use Top Down Design and In-Context editing. 
    Explode and collapse SolidWorks assemblies. 
 Animate the explosion or collapse of an assembly. 
 Create multiple versions of an assembly. 

11.2 Introduction 

One benefit of solid modeling is that we can check for interference 
between parts. It is cheaper and faster to fix interference problems in 
the model than in real parts. Now, we will check the tire sub-assembly 
for interferences. If you have completed the Truck sub-assembly 
(Practice Exercise 2 in Lesson 10 and drawing SKBD110) and the Top 
Skateboard assembly (Practice Exercise 3 in Lesson 10 and drawing 
SKBD100) you can check those also. 

11.3 Detecting Interferences 

Step 86:  Click Open and select the tire sub-assembly. 

 On the Main Drop-down Menu, select ToolsInterference to get 
the menu in Figure 11.1. There should be no interferences detected 
as shown in the figure. 

 To correct interferences, you can edit the Part model or edit In-
Context. Any changes will be reflected in the assembly and in the assembly drawing. 

Figure 11.1 – Checking 
for Interference in the 

Assembly 
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Editing In-Context. 

 In the FeatureManager design tree, right-click on the part that you want to edit and 
select Open Part or Edit Part. 

 Open Part will open the Part file and you will work on the part without the assembly. 

 Clicking Edit Part will do two things: 

1) The design tree of the part being edited will become blue, and 

2) In the solid model of the assembly, only the part being edited will remain solid 
and all the others will become transparent. You will be making changes in the 
context of the assembly. 

 Click the + sign to open the part design tree. 

 Make changes to the features or sketches. 

 To return to the assembly from the edit mode, right-click on the Top Assembly (first) 
icon in the design tree and select the Edit Assembly icon. All the parts will cease to be 
transparent. 

11.4 Detecting Collision 

Detecting collision when a mechanism moves is another useful feature in SolidWorks. Collisions 
are expensive and time consuming to fix. If you have completed the Truck sub-assembly you 
can collisions when the truck axle rotates about its pivot. 

Step 87:  Click Move Component or Rotate Component. 

 On the PropertyMenu, click Collision Detection. 

 Drag or rotate the moving part. 

 Depending of the options selected, you can stop the motion of colliding parts, make 
them change color, or make a sound. 
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11.5 The Exploded Assembly 

Exploded assemblies are very useful. It is 
easier to understand complex assemblies and 
the assembly sequence when the components 
are shown exploded. 

Step 88:  Exploding the tire assembly. 

 Click on the ConfigurationManager 
icon to get Figure 11.2. 

 The figure shows only one 
configuration called Default. It is the 
name that SolidWorks gave the 
assembly we created earlier. 

 Right-click Default and select New Exploded View to get the menu in Figure 11.3. 

Step 89: Click on one assembly component to show the manipulator handle. 

 Click and drag the handle in the direction you wish to explode. 

 Release the mouse button to release the part. 

 Repeat for every part until you have the fully exploded configuration that you want. See 
Figure 11.4. 

 Notice that you can drag any number of components simultaneously by first clicking to 
make them active, and then dragging the manipulator handle. 

Step 90: After saving the exploded configuration, it is possible to toggle between the exploded and 
normal configuration by right-clicking on AssemblyConfiguration and changing between 
Collapse and Explode. 

Step 91: Right-click again on AssemblyConfiguration and select Animate collapse or Animate 
explode. 

 The menu in Figure 11.5 will appear to allow the user to control the animation. Table 
11.1 shows what options are available. 

 

 

 

Figure 11.2 – ConfigurationManager showing the 
Default Configuration 
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Figure 11.3 – Exploded Assembly 

Figure 11.4 – Creating the 
Exploded View 

Figure 11.5 – Explode Animation Menu 

  Page 110 



Lesson 11 – Detecting Interference, Editing and Exploding the Assembly and Creating Multiple  
Assembly Configurations 

Section IV – Modeling Assemblies  11.6 Multiple Assembly Configurations 
 
 

 

 

11.6 Multiple Assembly Configurations 

In Section 11.5 we created an exploded wheel assembly. In this section we will create a new 
configuration with a green tire. 

Step 92:  Right-click the Tire and select Edit Feature. 

 Verify that you have the FeatureManager design tree. 

 Notice that the Tire feature changes to blue to show that the tire is being edited. 

 On the Feature/Property/Configuration manager tabs (see Figure 1.4), click the arrow to 
show the Display Pane (see Figures 11.6 and 11.7). 

 Under the colored ball for “Appearances”, click the line for the tire and select 
Appearance. 

 Select and click on a green color that you like and then click on the checkmark to accept. 

Step 93: Right-click the Tire again and select Edit Assembly to save the changes and return to the 
assembly. 

 
  

Table 11.1 – Explode Animation Control 
Icon 

Number Action 

1 Return the animation to frame one. Click Start after selecting this choice. 

2 Rewind (play back) the animation. Click Start after selecting this choice. 

3 Start 

4 Fast forward. Click Start after selecting this choice. 

5 Pause the animation. Click Start after selecting this choice. 

6 Stop 

7 Save the animation. 

8 When 8 is selected, the animation plays start-to-end once. 

9 When 9 is selected, the animation loops or plays beginning-to-end continuously. 

10 When 10 is selected the animation reciprocates between explode-collapse-explode. 
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Step 94:  Create a new configuration. 

 Click the ConfigurationManager tab. 

 Click Wheel_ Assembly and right-click to show the menu. 

Figure 11.7 – Green Tire 

  

Figure 11.16a-
Feature/Property/Configuration 
manager tabs. 

Figure 11.16b-
Feature/Property/Configuration 
manager tabs with Display Pane. 
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 Click Add Configuration. Name the new configuration “Green” and click the check mark 

to accept. 

 A new configuration named “Green” is created. 

Step 95: Save the model. It will have two configurations. 
 

 

 

Top Down Design 
 
Top down design can be used to make changes to a component that does not fit correctly 
into an assembly. It can be also used to create a new component or a new feature in an 
existing component, if they are part of an assembly. Although top down design is an 
advanced topic and is beyond the scope of this book, it is useful to have an introduction to 
the subject because it is a powerful tool. 
 
One variation of top down design is in-context design.  For example, if the diameter of the 
tire must be made larger and we want to verify that it is not too large and it still fits under the 
deck, we can use in-context design. On the skateboard final assembly (SKBD100):  
 

 Notice that we have in the FeatureManager design tree, the design 
trees for each part. They can be expanded by clicking on the (+) sign. 
Similarly, the steps can be hidden by clicking the (-) sign. 

 
 Right-click on the tire (or the tire feature in design tree) to get a pull-

down menu and click the icon Edit Part to edit the part in the context 
of the assembly.  

 
Note: Alternatively, we can click the icon Open Part to edit the part by 
itself without the assembly. 

 
 On the design tree, click the feature or the sketch that must be 

changed. 
 

 When the changes have been completed, you can return to the 
assembly by first right-clicking on the part or the design tree to get the 
pull-down menu and then clicking Edit Assembly.  
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Practice Exercises 

1. Move the wheel bearings from the Wheel Assembly to the Truck Sub-Assembly. 

Practice Problems 

1. Discuss the advantages and disadvantages of including the wheel bearings in the Wheel 
Assembly vs. the Truck Sub-Assembly. 
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SolidProfessor tutorials: http://www.solidprofessor.com/ 
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Drafting Standards 
 

Drafting standards are needed because drawings must be understood by every interested 
party irrespective of language, cultural or geography barriers. The easiest way to 
accomplish this is with a set of codified rules available to all. The Drafting standards list the 
rules to be used when creating or interpreting technical drawings. The two most widespread 
drafting standards are ANSI and the ISO. The first because it is the most common in the 
United States and the second because it is the most popular in the rest of the world. The 
ISO standard allows for customization and most countries have their local version. The 
ANSI standard has converged towards ISO and to some extent it can be said that ANSI is 
the U.S. version of the ANSI standard. 
 
The ANSI Drafting Standard 
 
ANSI is the abbreviation for American National Standards Institute. ANSI is a private, non-
profit organization whose charter is to coordinate the development of voluntary consensus 
standards. Also, ANSI is the United States representative to ISO, an international 
organization also involved in the creation of standards. ANSI´s mission is: 

 
To enhance both the global competitiveness of U.S. business and the U.S. quality of 
life by promoting and facilitating voluntary consensus standards and conformity 
assessment systems, and safeguarding their integrity. (From http://www.ansi.org) 
 

The members of ANSI are companies, government agencies, universities and individuals 
interested in the creation, use, and maintenance of standards and on the certification of 
products and personnel to the standards. ANSI coordinates but not produce the standards. 
The standards are produced by the member companies, organizations and individuals that 
have an interest in the subject. Typically, a draft of the standard produced by a member is 
circulated to others for changes and eventual approval by consensus.   
 
Technical drawings that follow the ANSI standard are drawn in inches or millimeters and 
are projected in the third quadrant or angle. 
 
The ISO Drafting Standard 
 
The organization known as ISO is chartered to create standards that are accepted and can 
be used worldwide. The name ISO means equal and is derived from the Greek word isos 
(ἴσος). ISO was chosen to avoid having different abbreviations in the various languages.  
ISO’s headquarter is in Geneva, Switzerland and its members represent 164 countries as of 
2014. This compares with 193 countries in the United Nations. Thus, almost all the 
countries of the world with manufacturing or international trade economic sectors are 
represented in ISO. Each country sends a delegation to the annual general assembly and 
provides experts to staff the various committees. Most delegations are the host country´s 
standards organization. For example, ANSI (American National Standards Institute) 
represents the United States in the ISO general assembly and in committees and is one of 
the important standards organization in the United States. 
 
ISO drawings use strictly millimeters only and are projected in the first quadrant or angle. 
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Lesson 12 – Creating Detail Drawings 

12.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Explain the need for working drawings. 
 Explain the difference between detail drawings and assembly drawings. 
 Customize SolidWorks by creating a drawing template. 
 Explain and create detail drawings in SolidWorks. 
 Explain and create assembly drawings in SolidWorks. 
 Explain the detail drawing title block. 
• Create the drawing for the Skateboard Deck. Instructions for creating other drawings can 

be found at the website www.cadeducators.com or in the step by step videos also 
available in the website.  

12.2 Introduction 

Working drawings are the primary means of communication between designers and fabricators. 
They describe each part needed to make a product and how they are assembled. There are 
three kinds of drawings in a complete set of working drawings: 

1) detail drawings, 

2) assembly drawings, and 

3) the bill of materials. 

Sometimes, the assembly drawing and the bill of materials are combined into one drawing. 

Each detail drawing has the instructions for making one part. The instructions include all 
dimensions, the material to be used, and the finish, such as painting plating or protecting with 
grease. In some situations, even the storage instructions are recorded in the drawing. 

Assembly drawings describe how the parts are assembled. They are rarely used by the person 
making a part. Instead, they are the instructions for the person or persons responsible for the 
assembly of the product. Every assembly drawing needs a bill of materials or BOM. The BOM is 
a list of all the parts needed to assemble the product or sub-assembly. In practice, the person 
assembling the product will first verify that all the parts are available before assembly begins. 

Drawings are also used by the maintenance organization when a repair or upgrade is 
necessary. For this reason, maintenance information should be included as notes in the detail or 
assembly drawings. Finally, the design and the maintenance organizations need information 
about the changes made to the product over the years. In this role, drawings are historical 
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documents that can be used to reconstruct the original design and all the changes. This 
information is usually found in the change block. 

12.3 Creating a Drawing Template 

We will create a drawing template to customize SolidWorks. Drawing templates must follow 
standards, for example ANSI or ISO. 

Step 96:  Open a new document and specify Drawing as the type of document. A new drawing 
Format and Size selection panel is shown in Figure 12.1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Click Browse and navigate to the location where SolidWorks stores the drawings 
templates in your computer or network. See Figure 12.2a. 

 Select a – landscape.slddrt. 

 Click Open and then click OK. 

 You will get the Drawing document on Figure 12.2b. 

 

 

 

Figure 12.1 – New Drawing Format and Size Properties 
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Figure 12.2b – New Drawing Document 

 Figure 12.1a – SolidWorks Drawing Format Templates 
 

   Page 120 



Lesson 12 – Creating Detail Drawings 
  Internet Resources 

Step 97:  We will now create a template for the A-size Landscape drawings. 
 Click on ToolsCustomize on the Main Pull-down Menu or on OptionsCustomize 

on the Quick Access 
Toolbar and select the 
Toolbars tab to get the 
dialog box in Figure 
12.3. 

 Verify that the 
CommandManager is 
enabled. 

 Verify that the Task 
Pane and View 
(Heads-Up) toolbars 
are enabled. 

 Verify that in Context 
toolbar settings, Show 
on selection and Show 
on shortcut menu 
have a check mark. See 
Figure 12.3. 

Step 98:  Select System Options 

 Click ToolsOptions 
on the Main Pull-down 
Menu or Options on 
the Quick Access Toolbar and select the System Options tab. 

 Click Display Style and verify that hidden lines and tangent edges are removed. 

 In ToolsOptions select the System Options tab, click FeatureManager and verify 
that the Design Binder pull-down menu says Show. 

 Your screen should look like Figure 12.4. 

Figure 12.2 – ToolsCustomizeToolbars 
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Step 99:  Select Document Properties 

 Select the Document Properties tab and verify the following choices: 

 Drafting Standard – Verify that ANSI is selected as the drafting standard. See Figure 
12.5. 

 Units – Select IPS (inches, pounds, and seconds). 

 Click OK. 

Figure 12.3 – ToolsOptionsSystem Options 
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Step 100:  Enter the Title Block information. 

 Your screen should look like Figure 12.2b. 

 Right-click in the graphics area and select Edit Sheet Format to change the Title Block. 

 On the space above the Title, type your name or the name of your school or company. 
To type your name, right click and select AnnotationsNote.  

 After you finish typing, click to locate the name and then press Escape on your keyboard. 
This will prevent duplicating the name everywhere 
you click. 

 Double-click the box with the TOLERANCES shown 
on figure 12.6. Now you can make changes. We will 
add the tolerances for machining and bending in 
degrees. 

 Click after FRACTIONAL± and add 1/16. 

 Click after ANGULAR: MACH± and add 1. 

Figure 12.4 – ToolsOptionsDocument Properties 

Figure 12.5 – Tolerances in the Title 
Block 
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 Add 1 after BEND±. to indicate 1 degree tolerance. 

 After TWO PLACE Decimal ± add 0 .01 and for THREE PLACE DECIMAL ± add 0.005. 

 See Figure 12.6. 

 Click the Edit Sheet icon on the upper right corner of the screen or Right-click the 
graphics area and select Edit Sheet. 

 Click FileSave as and select Drawing Template in the pull down menu. Name the 
template ANSIinchLandscapeA.drwdot. 

 

 
 

12.4 Creating a Detail Drawing of the Skateboard Deck 

Each part in a product must have a detail drawing. A detail drawing has all the information 
needed to manufacture the part, including dimensions, the material, heat treatment, finish and 
all other relevant information. In addition, a detail drawing’s title block will have the part name 
and part number, the name of the designer and other information that can help locate old 
drawings and the people involved in their creation. 

Step 101:  Open a new document and select the A-size drawing template created in the previous 
section. Notice that the CommandManager now has tabs for View Layout and Annotation.  

 Click InsertDrawing View Model on the Main Pull-down Menu or click Model 
View on the CommandManager to get the dialog box in Figure 12.7. 

 Click Browse and locate your skateboard deck model. 

Tolerances 
The title block tolerances are the default values and are included in the organization’s 
drafting practices manual. They are based on industry experience and manufacturing 
capabilities. The best tolerance is one that insures that the product can be assembled easily 
and works as designed. Geometric Dimensioning and Tolerancing as defined in ASME Y14.5 
and its ISO equivalent, defines the rules and practices that will achieve optimum tolerances 
consistently. 

Cleaning-Up your Model or Drawing 
As you create your model or drawing you can find that you need information such as 
axes, planes, origins, relationships and other references. However, such information do 
not belong in a drawing and can be distracting when you show your models to others. To 
clean-up your model or drawing for presentation to others, click ViewHide All Types. 
This will hide all unnecessary references, which can be brought back by clicking again. 
You can also choose to hide specific information only. 
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 Click Open or double click the 
model. 

 Click the Next arrow to get the 
dialog box in Figure 12.8. 

 In Orientation, select the 
Front view, drag the cursor to 
the location you want place the 
Deck and click and release the 
left mouse button. 

 The first view that you drag to 
the graphics area becomes 
your Front View.  

 If you drag and click you can 
also place the Top View, the 
Right View and the Isometric 
View at 45 degrees. These are 
the typical views used in 
technical drawings. See 
drawing SKBD101 in Appendix 
A. 

 Click the check mark or press 
Escape on the keyboard to 
accept your choice of views. 

 If you selected the best 
sketching plane when you 
created the model, you have 
appropriate views. If you did 
not choose a good sketching 
plane, you can try again by undoing what you have and 
selecting another starting view to get a better combination of 
views. This can be confusing. 

 To move the Front view to a new location, move your cursor over the Front view 
dashed lines or model and click and drag. Release at the new location. If you have 
additional views, you will notice that all the views move together. 

 To move the other views, you also click on the dashed line or the part, but you can move 
in only one direction. Only the Front View, the first one placed on the graphics area, can 
move in two directions. 

 If you need additional views after you accept your earlier choice, click the Projected 
View icon on the View Layout tab, click a view and drag and release to create 
additional views. 

 In our deck example we need the Front, Top, Right and Isometric Views. See drawing 
SKBD101 in Appendix A. 

Figure 12.6 – InsertDrawing 
ViewModel 
Property Manager 

Figure 12.7 – Insert Front 
View 
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 If you click one view to make it active and 
then click Display Style on the View 
(Heads-Up) toolbar you will notice that 
the view has Hidden Lines Removed. 
Most engineering organizations use this 
option instead of showing hidden lines 
because hidden lines can result in 
confusion when drawing complex parts. 
Instead of hidden lines, most organizations 
use sections and additional views to show 
details not seen on the primary views. 

 Change the Isometric View to include Shaded with Edges to get a more realistic 
representation. 

 Click and drag each of the views to notice that: 

1. When moving the Front view, the Top and Right views also move. 

2. The Top view moves only up and down and will always stay aligned with the 
Front view. 

3. The Right view also stays aligned with the Front view. 

4. The Isometric view is free to move in any direction. 

 If you can see the blue origin in your drawing, you can toggle on/off by clicking View on 
the Main Pull-down Menu and clicking Origins. Other View menu options include: 
Temporary Axes, Points, Sketch Relations and others. They do not belong in a 
drawing. For drawings, it is best to select Hide All Types. 

 Click ViewHide All Types and save your drawing as SKBD101. 
 

 
 

Drafting Standards 
Drawings are legal documents and are in court to adjudicate fault in negligence cases. For that 
reason, they must be accurate and correct. Many reviews by multiple reviewers are needed to 
insure accuracy and correctness and this makes the process of producing drawings labor and 
time intensive.  
Although computers and CAD software like SolidWorks have reduced the time and effort 
necessary to create drawings, they have not replaced humans. The creation of drawings is 
more art than science and only humans can decide what is appropriate and looks best. There 
are guidelines developed from experience that can help produce attractive and complete 
drawings with all the information needed to build a product or structure. These guidelines are 
usually collected in standards and drafting practice manuals. Two popular standards are ANSI 
and ISO. ANSI (American National Standards Institute) is common in the United States, 
Canada and the U.K. while ISO (International Organization for Standardization) is used 
worldwide. In addition, every engineering organization will have a proprietary drafting practices 
manual. 

Part Names and Part Numbers 
Parts are tracked by their part number, not 
their part name. The reason is that it is 
easier to organize, store and retrieve a 
sequence of numbers than descriptive 
names. A part number will typically include 
information about the project and the 
assembly where it belongs. 
This is the reason why SolidWorks stores 
the name you use to save your drawing as 
the part number.  
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Step 102:  Next, we will insert vertical break and detail views. 

 Vertical and horizontal breaks are used when objects have one dimension that is 
significantly larger than the others, for example flagpoles and pipelines. The break 
allows them to be drawn in a scale that shows the smaller dimensions clearly. 

 Click to select the Front view and click InsertDrawing ViewVertical Break on the 
Main Pull-down Menu or click Break on the CommandManagerView Layout tab to 
get the PropertyManager. 

 Move the cursor to the location where you want to place the first break line and click. 

 Double-click to place the second line. 

 Click the check mark or press Escape on the keyboard to accept. 

 Repeat the previous step to create a break in the Top view. The results are shown in the 
detail drawing SKBD101 in Appendix A. 

 To see the edge chamfer clearly, we will create a detail view. 

 Click InsertDrawing ViewDetail. 

 Click in the middle of the area that you want to include in your detail view and drag the 
cursor to create a circle. 

 Release the mouse button. 

 Drag the detail view to the location you want and click again to release. 

 Save your drawing again. Verify that the file name is SKBD101.drw. 

Step 103:  Dimensioning is both, a science with rules, and also art, where the designer must be 
aware of aesthetics. 

 It is possible to conceive multiple arrangements of dimensions that are valid and 
acceptable but different. 

 The most important rules are: 

1. The drawing must have all the dimensions needed to fabricate the part. 

2. Dimensions shall never be repeated. Never double dimension. 

3. Dimension the most logical view. 

4. Group related dimensions in the same view. 

5. Use clear dimensions that can be interpreted only one way. 

6. Minimize the accumulation of tolerances. 

7. Avoid dimensions to hidden lines, if possible. 

8. Never dimension inside the part. 

All the rules can be overruled to make the drawing clear and aesthetically pleasant. 
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Step 104:  To create dimensions in SolidWorks drawings, use Smart Dimension and: 

1. click a line to display its length dimension, or 

2. click each of the two points at the end of a line to show the distance between the 
points, which is also the length of the line, or 

3. click two parallel lines to display the distance between the lines, or 

4. click two lines that are not parallel to display the angle, or 

5. click a diameter of a circle or an arc to display their diameter or radius. 

 
 When you click a dimension it becomes active and you can see the dimension 

PropertyManager. See Figure 12.9. 

 

 

 

Figure 12.9 – PropertyManager 
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 The options in the PropertyManager can be used to tailor how dimensions are 
displayed. For example: 

1. Change the number of decimal points in the dimension in the 
Tolerance/Precision box. You can also add tolerances to your dimensions by 
using the appropriate menu choice. See Figure 12.10. 

2. You can add symbols in the Dimension Text box. In the example, 2X was added 
by clicking to the left of <DIM> and adding the text. 

3. The arrows can be placed inside or outside of the leader lines by selecting the 
proper choice on the Leaders tab. 

 Click Save As and use SKBD101 as the filename. 

Step 105:  The last step is to fill the missing information in the title block. To toggle between making 
changes to the drawing and making changes to the title block: 

 Right-click in a blank space in the graphics area and select Edit Sheet Format. 

 Be aware that right-clicking close to one of the views will make it active and Edit Sheet 
Format will not be available. 

Step 106:  In the Edit Sheet Format mode, the information in the title block can be added or 
changed. 

 Double click the location to open the input box and type the information. 

 Click to accept the text and press escape to finish. 

 If double clicking does not open the input box, right-click to show the menu and select 
AnnotationNote, drag the annotation box to the desired location, and click to release. 

 Add the name of the part, the material and the finish as shown in SKBD101.  

 To exit the Edit Sheet Format mode, right-click in a blank space in the graphics area 
and select Edit Sheet, or click on the Edit Sheet icon on the upper-right corner of your 
screen. 

 Open the Design Binder and add your name, date and other useful information to the 
Journal and save your SkateboardDeck drawing again as SKBD101. 

 

 

 

 

 

 

Using Drawing Tables 
 

Storing drawings used to be a very expensive requirement. Even today, with CAD 
and electronic drawings, Storage is still a concern. As a result, most organizations 
minimize the number of drawings created. In situations where the dimensions of 
similar parts are different, it is possible to use a Table to specify multiple parts in 
the same drawing. Drawing SKBD116 representing the two spacers is an 
example. To create a Table, click InsertTableGeneral Table.  
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12.5 Creating Detail Drawings for Commercial Items 

Some engineering organizations produce a separate detail drawing for each commercial part, 
such as a bearing or a specific type of nut or bolt. Other organizations do not produce drawings 
for commercial items and simply keep the information in a database and print what is needed.  

Commercial items are not manufactured by the company that uses them. They are purchased 
by what is typically called the Purchase or Procurement group. The information they need is the 
part number or identifying number (sometimes called the SKU or Stock Keeping Unit), the 
quantity of parts needed and the name, address and telephone number of one or more 
suppliers. In addition, a picture of the part can be helpful. Figure 12.10 is an example of a detail 
drawing for a commercial bearing. 

12.6 Creating e-Drawings 

SolidWorks eDrawings can be used to share solid models and drawings when the recipient 
does not have SolidWorks. A free viewer can be downloaded from 
http://www.edrawingsviewer.com/ or in http://www.solidworks.com. Also, it was probably 
installed on your computer as part of the SolidWorks installation. 

Step 107: There are two ways to create an eDrawing: 

1) use the command Save As on the File pull-down menu of the Main Drop-down Menu 
and select eDrawing on the pull-down menu for Save as type, or 

 
Figure 12.10- Example of Detail Drawing for a Commercial Item 
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2) click FilePublish eDrawing File on the File pull-down menu of the Main Drop-down 
Menu. 

 

  
 

12.7 Using the Spell Checker 

To use the spell checker we must first verify that SolidWorks has access to a dictionary. If your 
computer has Microsoft Office installed, you have satisfied this requirement. 

Step 108:  To spell-check you document: 

 Click ToolsSpelling on the Main Drop-down Menu. 

 The spelling checker will report any typographical error in the drawing. 

Practice Exercises 

1. Describe the FeatureManager design tree for a drawing. 

2. Check the spelling in your Skateboard Deck drawing (SKBD101). 

3. Click HelpSolidWorks Help in the Main Drop-down Menu and select Contents and 
study the section Derived Drawing Views. List and describe what views are available in 
SolidWorks. 

Questions 

1. Suggest what manufacturing processes can be used to make one part in the skateboard. 

2. Develop an assembly sequence to put together the skateboard. 

3. What is ANSI? 

4. What is ISO? 

Sharing Drawings 
Often, it is necessary to share drawings and other design information with co-workers, customers and 
other stakeholders. Unfortunately, to open SolidWorks files we need the software. If you want to share 
drawings and the recipient does not have SolidWorks, you can use the command Save As and select 
PDF or JPEG format. Most personal computers will be able to open these formats. If the recipient has 
AutoCAD software, you can save your files as DXF (Drawing Exchange File). Other file formats that 
you can use are IGES, STEP and STL. All are available in some versions of SolidWorks. Translators 
to most CAD formats, including ProE, CATIA, Rhino, etc., are also available. 
If you save your drawings as detached drawings (.slwddrw), the recipient does not need the solid 
models to open the drawings, but must have SolidWorks to open them. Finally, another useful 
alternative is to save your work as e-Drawings. This is a free application available at SolidWorks.com 
that you can use to view and mark-up drawings.     
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5. Click ToolsOptionsDocument Properties and find what other drafting standards 
are available besides ANSI and ISO. Where are they popular? 

6. Explain what is/are: 
a. Nominal size.                                     h.Datum. 
b. Basic size.                                         i.Dimension lines. 
c. Actual size.                                        j.Extension lines. 
d. True position.                                    k.Leader lines. 
e. True radius.                                       l.Section view. 
f. Limit dimensions.                              m.Detail view.  
g. Reference dimensions.                     n.Broken-out section. 

References 
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ANSI Standard 
Engineering Drawing and Design – by D.A. Madsen and D.P. Madsen, Cengage Learning, 
Clifton Park, NY, US 

Interpreting Engineering Drawings – C. Jensen and J.D. Helsel, Cengage Learning, Clifton 
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British (BSI) Standard 
Manual of Engineering Drawing – by C.H. Simmons, N. Phelps and D.E. Maguire, Elsevier, 
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• Model View 
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Videos from SolidProfessor SolidWorks for Beginners 

• Associativity 
• Annotations 

 
Videos from SolidProfessor Core Concepts for Drawings 

• Auxiliary View 
• Broken View 
• Scale 
• Custom Properties and Parametric Notes 

 
Videos from SolidProfessor Intro to eDrawings 

• eDrawings Overview 

Internet Resources 

CADeducators website: http://www.cadeducators.com/ansi-english.php  

                                       http://www.cadeducators.com/iso-english.php  

American National Standards Institute (ANSI) website: http://www.ansi.org 

International Standards Organization (ISO) website: http://www.iso.org 

Wikipedia.com: http://en.wikipedia.org/wiki/Engineering_drawing 

NASA Technical Drawings: http://history.nasa.gov/diagrams/diagrams.htm
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Lesson 13 – Creating the Assembly 
Drawing with the BOM 

13.1 Lesson Objectives 

After completing this Lesson, you will be able to: 
 Explain and create assembly drawings in SolidWorks. 
 Explain and create the Bill of Materials. 
 Explain the assembly drawing title block. 
 Explain and use balloons in the assembly drawing. 
 Explain and use the Balloon and AutoBalloon commands. 

13.2 Introduction 

The purpose of the assembly drawing is to provide the information needed to assemble the 
product. The person or team assembling the product from parts does not need the exact 
dimensions of the parts, or the material used to make them. What they need is an exploded 
assembly drawing showing the sequence in which the components are added to the assembly. 

A Bill of Materials (BOM) is a list of all the parts and commercial components in the assembly. 
Often it is included in the assembly drawing, but for large assemblies it is more convenient if the 
BOM is on a separate sheet. In practice, the person assembling the product will verify that all 
the parts are available by comparing the bill of materials with the parts available. Typically they 
do this before the process of assembly begins. 

In this Lesson we will create an assembly drawing and BOM for the wheel and tire assembly. 

13.3 Creating the Assembly Drawing 

The assembly drawing will use the ANSIinchLandscapeA template we created earlier. 

Step 109:  Open a new drawing document and select the template ANSIinchLandscapeA. 

 Click InsertDrawing ViewModel on the Main Pull-down Menu or click Model View 
on the CommandManager  

 Click Browse and find the model of the tire assembly. 

 Click the tire assembly and then click OK. This will get the tire assembly model into the 
drawing document. 
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 In Orientation, select the Isometric view. We could also choose to present the 
assembly as multiple orthogonal views, similar to a detail drawing.  

 At the bottom of the properties menu, click More Options. 

 Select Show in exploded state. 

 Click the check mark to accept. 

 Repeat InsertDrawing ViewModel, but do not explode the assembly. 

 Click each of the views and select Display StateShaded With Edges. 

 Click Save As and use the file name SKBD120. 

Step 110:  Right-click and choose Edit Sheet Format and fill the title block. 

 Tolerances, materials and finish are never filled on assembly drawings. This is because 
each of the parts in the assembly can be made of a different material and can be 
manufactured with different tolerances. 

 The wheel assembly drawing can be found in Appendix A and can be used as a 
reference when completing the title block. 

 Save your drawing again. 

Adding Sheets to your Drawing 
 

As your drawing becomes more complex, you may decide to use multiple 
pages or sheets. To add additional sheets to your drawing, right click in 
the Graphics area, away from your drawing, and select “Add sheet”. 
 
To delete a sheet click “Delete”. 
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  13.4 Adding the BOM 

13.4 Adding the BOM 

Step 111:  Click InsertTablesBill of Materials on the Main Pull-
down Menu. 

 Click the skateboard assembly to open the BOM dialog box 
in Figure 13.1. Accept the default options. 

 Click the check mark to accept and drag the mouse to 
position the BOM table on the top-left corner. See Figure 
SKBD120 in Appendix A. 

 To add a column or row to the BOM table, right-click over 
the table and select InsertColumn or InsertRow. 

 To type or make changes, double-click on a table cell. 

 To exit the edit mode, click outside the BOM. 

Step 112:  Add balloons one at a time with the Balloon command in 
the CommandManager’s Annotations tab, or use the 
AutoBalloon command. The balloons can be moved with click-
drag. 

 Notice that SolidWorks already knows which part you want 
to label with a balloon. You provided this information when 
you created the assembly. 

Step 113: Step 98: Save your drawing a third time. Remember that the 
filename is SKBD120. 

 

Figure 13.1 – Bill of Materials 
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  Practice Exercises 

Practice Exercises 

1. Move the BOM to Sheet 2 of the assembly drawing. (Hint: Right-click and then click Add 
Sheet. Notice that Sheet1 and Sheet2 tabs are shown at the bottom of the 
FeatureManager design tree.) 

2. Add a Part Description column to the BOM table. 

3. Create the assembly drawing for the Truck Sub-Assembly. (Hint: You can use the 
drawing in the Appendix for reference.) 

4. Create the drawing for the skateboard top assembly. (Hint: You can use the drawing in 
the Appendix for reference.) 

5. Find the keyboard shortcut to spell check a document. (Hint: You will find the Spell 
Check command in ToolsCustomizeKeyboard. The command is in the Others 
category. If you lose your geometry after you spell-check, use the Zoom to Fit and 
Rotate View commands to bring it back into view. 

Problems 

1. List the parts in a pencil. Do you recommend the use of sub-assemblies? 

References 

SolidWorks Bible – by Matt Lombard, John Wiley and Sons, Indianapolis, IN, US 

SolidWorks Office Training Manual – by SolidWorks Corporation, Waltham, Massachusetts, US 

SolidWorks 2014 Short and Simple – by OnlineInstructor.org 

Introduction to Using SoildWorks – by W.E. Howard and J.C. Musto, McGraw Hill, New York, 
NY, US 

ANSI Standard 
Engineering Drawing and Design – by D.A. Madsen and D.P. Madsen, Cengage Learning, 
Clifton Park, NY, US 

Interpreting Engineering Drawings – C. Jensen and J.D. Helsel, Cengage Learning, Clifton 
Park, NY, US 

British (BSI) Standard 
Manual of Engineering Drawing – by C.H. Simmons, N. Phelps and D.E. Maguire, Elsevier, 
Oxford, UK 
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  Internet Resources 

ISO Standard 
The Mechanical Engineering Drawing Desk Reference – by Paul Green, CreateSpace, Seattle, 
WA, US 
 
Videos from SolidProfessor 3D Skills 

• Bill of Materials 
• Balloons 

 
Videos from SolidProfessor SolidWorks for Beginners 

• Assembly Drawing 
 
Videos from SolidProfessor Core Concepts for Drawings 

• Formatting Dimensions 
• Custom Templates 
• Custom Properties and Parametric Notes 

Internet Resources 

CADeducators website: http://www.cadeducators.com/ansi-english.php  

                                       http://www.cadeducators.com/iso-english.php  

American National Standards Institute (ANSI) website: http://www.ansi.org 

International Standards Organization (ISO) website: http://www.iso.org 

Wikipedia.com: http://en.wikipedia.org/wiki/Engineering_drawing  

NASA Technical Drawings: http://history.nasa.gov/diagrams/diagrams.htm
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Drawings – ANSI/Inches 

 
 
  

 



 

  

 



 
Appendix A – Skateboard Working Drawings – ANSI/Inches 

 
A1 – SKATEBOARD ASSEMBLY 
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A2 – DECK 
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A3 – TRUCK SUB-ASSEMBLY 
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A4 – BASE 
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A5 – TRUCK AXLE 
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A6 – SPACER 
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A7 – FRONT SPACER 
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A8 – WHEEL ASSEMBLY 
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A9 – WHEEL 
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A10 – TIRE 
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Appendix B – Skateboard Working 
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B1 – SKATEBOARD ASSEMBLY 
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B2 – DECK 
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  Internet Resources 

B3 – TRUCK SUB-ASSEMBLY 
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  Internet Resources 

B4 – TRUCK BASE 
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  Internet Resources 

B5 – SKATEBOARD AXLE 
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B6 – SPACER 

 
  

   Page 162 



Lesson 13 – Creating the Assembly Drawing with the BOM 
  Internet Resources 

B7 – FRONT SPACER 

 
  

   Page 163 



Lesson 13 – Creating the Assembly Drawing with the BOM 
  Internet Resources 

B8 – WHEEL ASSEMBLY 
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B9 – WHEEL 
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B10 – TIRE 
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Appendix C – SolidWorks Task Pane 
 
  

 



 

  

 



 
Appendix C – SolidWorks Task Pane 

 

C1 – Tabs in the Task Pane (From: SolidWorks Help) 

Figure C1 shows the various tabs in the Task Pane (See Figure 1.4) and the information and 
resources it contains. Clicking any of the tabs will expand the Task Pane and clicking the 
graphics area will close it. Clicking the push-pin will keep the Task Pane open. 
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Appendix D – SolidWorks Main Pull-down 
Menu Commands 
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D1 – File Sub-Menu 
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D2 – Edit Sub-Menu 
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D3 – View Sub-Menu 
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D4 – Insert Sub-Menu 
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D5 – Tools Sub-Menu 
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Appendix D – SolidWorks Main Pull-down Menu Commands 

 
D6 – Window Sub-Menu 

 

D7 – Help Sub-Menu 
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CommandManager 

 
  

 



 

  

 



 
Appendix E – SolidWorks CommandManager 

 
E1 – Features 

 

E2 – Sketch 

 

E3 – Evaluate 

 

E4 – DimXpert 

 

E5 – Office Products 
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Appendix F – View (Heads-Up) Toolbar 

 
F1 – View (Heads-Up) Toolbar 
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Appendix G – Mouse Gestures 

 
G1 – Mouse Gestures 

 

Mouse gestures increase your productivity by presenting quick access common SolidWorks 
commands. To enable Mouse Gestures. To enable/disable mouse gestures, click 
ToolsCustomize in the Quick Access Toolbar. On the Mouse Gestures tab, select 
Enable/Disable and the number of gestures you want. Mouse Gestures are enabled by default 
during installation. 

To use Mouse Gestures, right-drag your mouse by pressing the right button and dragging. The 
drag direction will highlight one of the tools. To select another tool continue pressing and drag in 
the direction you want. 
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Appendix H – List of SolidWorks 
Toolbars 

 
  

 



 

  

 



 
Appendix H – List of SolidWorks Toolbars 

 
H1 – List of SolidWorks Toolbars 

You can display the list of available Toolbars by right-clicking anywhere in the CommandManager. You 
can also display any of the Toolbars by clicking and highlighting them (see the icon Features below).  
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Appendix I – SolidWorks Keyboard Commands 

 
I1 – SolidWorks Keyboard Commands 

Keyboard Commands are shortcuts you can use to instead of the icons in the Toolbars. 
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Appendix J – SolidWorks View Selector 
cube 
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Appendix J – SolidWorks View Selector cube 

 
J1 – SolidWorks View Selector cube 

You can use the View Selector cube to choose the model view (i.e. the angle from which you 
see your model or part). On the View (Heads-up) Toolbar, click Orientation and select the View 
Selector cube (see the Figure below).  Your model will be shown with Parts in-context, meaning 
that you will be able to see and choose the view that best shows what you want to see.  
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Add-Ins 15-16 

American National Standards Institute 
(ANSI) 117, 141-150 

Angle 31 

Animation 109-111 

Annotation 123, 129, 132 

Appearances 50, 67, 111 

Arc(s) 48, 84,128 

Area 88 

Assembly 99-104, 105 

Assembly drawings 133-136 

Assembly Mate(s) 103-104, 105 

Auxiliary View 132 

 

B 

Balloon 135-136 

Bill of Materials (BOM) 135-136 

Boken-out view 132 

 

C 

CAD (Computer Aided Design) 1, 57, 91, 93 

Cap screw 

Centerline 44-45, 78-79 

Center Rectangle 82 

Chamfer 33-34, 42 

Circle 46, 48, 49-50 

Circular Pattern 59 

Coincident Mate 101, 102, 104 

Coincident Relationship 58, 79, 81 

Collision 108, 114 

CommandManager 5, 23, 177 

Concentric Mate 104, 105 

Concentric Relationship 49 

Concurrent Engineering 1 

Configuration(s) 60, 61, 111-112 

ConfigurationManager 5, 60-61, 109 

Configuration Management 28 

Convert Entities 46-47, 48 

Corner Rectangle 44 

Cosmetic Threads 66 

Countersunk screw holes 

Customize 9-17 

 

D 

Design Binder 12, 27-28, 40 

Design intent 19, 27 

Design Library 3, 7, 92, 95, 104 

Detached drawing(s) 130 

Detail drawing(s) 118-129 
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Detail View 132  

Dimension(s) 42, 127-128, 132, 136 

Tolerance(s) 123, 127, 129 

DisplayManager 

Display Style 12, 33-34, 104 

Document Properties 12, 100, 122 

Dome 52-54, 70-72, 75 

Drawing(s) 118-130, 132 

Drawing Template 119-124, 136 

Drawing Tables 129 

 

E 

Ellipse 11 

eDrawing(s) 130, 132 

Edit 40, 47, 49, 52, 170 

appearance 50, 67, 111 

feature 52, 60,103, 111 

in context 108 

material 40, 50, 86, 88 

sheet/sheet format 123-124, 129 

sketch 47 

Entities 

Convert 46, 48 

Extend 74 

Mirror 78 

Offset 46, 48 

Trim 74 

Equations 77, 78 

Exploded Assembly 109, 114 

Extend Entities 74 

Extruded Boss/Base 32, 42 

Extruded Cut 53-54, 55 

 

F 

Fastener(s) 

Feature(s) 24, 177 

FeatureManager design tree 5, 38-39 

File Explorer 3 

Fillet 33, 42 

Filters 

Flat-head screw 

Fully Defined Sketch 26, 31-32, 42 

 

G 

Geometry 42, 55 

Gesture See Mouse Gestures 

Graphics Area 5 

 

H 

Heads-up View Toolbar 5, 9, 181 

Help 5, 174 

Hidden lines 33, 121,126-127 
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Hide/Show components 78, 87, 114, 124, 
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Holes 35-38, 42 

Hole Wizard 35-37, 42 

 

I 

IGES 93, 130 

Importing 91-94, 104 

In-context 107-108, 113-114 

Inference 24, 26, 58 

Interface 3-5, 8 

Interference 107, 114 

ISO 13, 153-162, 117 

Isometric view 25, 125 

 

J 

JPEG 130 

 

K 

Keyboard commands/shortcuts 193 

 

L 

Line 24, 29-32, 42, 44-45 

Linear Pattern 

Link dimensions 78 

Lofted Boss/Base 

 

M 

Main Pull-down Menu 5, 169-174 

Mass Properties 41, 86-88  

Mate(s) see Assembly Mate(s) 

Materials 40, 89, 135, 136 

Measure 89 

Microsoft Excel Spreadsheet 

Midplane 46, 50, 58 

Midpoint 24, 32 

Mirror 38-39, 42, 75 

Model view 124,132, 133 

Mouse Gestures 185 

Multibody 66, 68, 75 
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Normal to 25, 45, 66 
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Offset Entities 46, 48 

Overdefined Sketch 27, 42 
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Pan 
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Part 13-15, 18, 23-24 

Part Template 9-15, 
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Plane 19, 23, 25, 75, 89 
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Polygon(s) 

Primary View 

Product Data Management (PDM) 27 
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RapidSketch 61 

Rectangle 44-45, 48, 82 

Reference Geometry 69-70 
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Relations see Sketch Relations 

Repair Sketch 

Revolved Boss/Base 24, 27, 45, 48 

Revolved Cut 27, 55 

Rollback 55, 57, 61 

Rotate View 52, 136 
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Save 3, 13-14, 40, 100, 124  

Scaling geometry 130, 132 

Screw threads 

Section Properties 88 

Section View 46 

Settings, recommended 

Sheet format 123-125, 129, 136 

Shell 

SI units 

Sketch 8, 11, 19, 23-26, 28-31, 42, 55, 61 

SketchXpert 89 

Sketch Fillet 34, 42 

Sketch Relations 23, 26, 61, 78 

Slot 73 

Smart Dimension 26, 30-31, 42, 77, 127 

Solid Modeling 105 

SolidWorks 8 

Spline 

Status Bar 5, 30, 27 

Sub-Assembly 6, 100-104, 105 

Suppress 
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Symmetry 

System settings 
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TIFF 93-94 
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Transparency 
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Under Defined Geometry 
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View 2, 5, 16-17, 59, 130, 171, 181 

View Manipulation 18 
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BIOGRAPHY 

Mario H. Castro-Cedeño has over 30 years of experience as an 
engineer working in industry, government and academia. His duties 
have included mechanical and materials engineering, corrosion 
research, project engineering and project management. He also has 
occupied positions in engineering management. 

In this book he teaches how to use SolidWorks as a tool for developing 
and presenting engineering ideas and concepts. In addition to teaching 
the basics of SolidWorks, he shares his experience related to how 
these tools are used in an engineering organization. 

The book is divided into the following five sections: 

1. Introducing and Customizing SolidWorks 

2. Modeling Simple Parts 

3. Modeling Complex Parts 

4. Modeling Assemblies 

5. Creating Engineering Drawings 

Unique amongst introductory SolidWorks tutorials, this book teaches how to read engineering 
drawings in parallel with learning to use SolidWorks. This is done by re-creating the model from 
the drawings included. 
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